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KNOW BEFORE YOU GO
 X (1/12/2022) Exam >Layout(s) > EDITED: MH Intake

• The 'ReviewOfSystems' tab was replaced with the new tab 'ReviewofSystemsNew'.
          • This tab contains the new 'ROS' memo field with an ellipsis hover menu.

 X (1/7/2022) Exam >Layout(s) > EDITED: See Below

• The 'ReviewOfSystems' tab was replaced with the new tab 'ReviewofSystemsNew' on the 
   layouts listed below.
• This tab contains the new 'ROS' memo field with an ellipsis hover menu.
• Layouts edited:
          • Med Management w/Treatment
          • Medication Monitoring
          • MH Intake
          • MH Intake w/ROS, HH
          • MH Intake with Addiction
          • Nutrition Assessment
          • Psych Follow Up w/Treatment
          • PsychChildFollowUp w/Trmt
          • PsychChildInitialEval w/Trmt
          • PsychiatricFollowUp
          • PsychiatricInitialEval

 X (1/18/2022) Exam >Tab(s) > ADDED: HiResCompMHNew

• This tab was created to replace the legacy tab 'HiResCompMH'.
• The legacy tab was copied, and the 'ROS' section was updated to the new memo field 
   with options on the ellipsis hover menu.

 X (2/24/2022) Exam >Tab(s) > ADDED: PopUpROS

• Tab Name: PopUpROS
• Tab Label: PopUpROS

• This NEW tab contains the individual Review of Systems fields.
• Accessed from the 'Comprehensive ROS' option on the ellipsis hover menu on the new 
   'ROS' memo field.
• Once the individual fields are populated, and the screen is saved, the data will populate 
   the 'ROS' memo field.

 X (1/12/2022) Exam >Tab(s) > ADDED: ReviewofSystemsNew

• Tab Name: ReviewofSystemsNew
• Tab Label: ROS

• This NEW tab is a copy of the 'ReviewofSystems' tab.
          • It contains the new 'ROS' memo field with an ellipsis hover menu.

 X (3/23/2022) Function >Insurance Activities > Claim Report Viewer > NEICSSL 
Program Retired

• Program Retired
          • Upon update to version 12.5, the NEICSSL program will be retired, and no longer 
             function for Electronic Billing Claim functions.
          • The shortcut to the program on your desktop will no longer function.
          • The creation of the billing files through 'Function > Insurance Activities > Billing' 
             has not changed.
          • There are no changes to the number of reports, timing or how they are pulled.
          • For those clients that chose to turn off the functionality of automatically uploading 

Compulink Healthcare Solutions | 1100 Business Center Circle | Newbury Park, CA 91320 | 805.716.8677 .
elearning@compulinkadvantage.com | www.compulinkadvantage.com              2



KNOW BEFORE YOU GO
             claims, they will need to contact the Compulink EDI Support Team Immediately 
             after updating to Version 12.5 to have it turned back on (805-716-8677).
                    • This option became available in Version 12.3.
                    • It was a change only a few Users chose to make.

• Function Added
          • The new function 'Claim Report Viewer' was added into the Advantage software to 
             replace the retired desktop program.
          • From the main menu, click 'Function > Insurance Activities > Claim Report Viewer.
          • This opens the 'CHS EDI Utilities' window; it is very similar to the retired viewer.
                    • Items marked as ‘No change’ below, still function the same as they did in 
                       the retired viewer
          • Tools:
                    • Delete Claim File – No change
                              • This option should be used with caution! 
                    • Resend Change Health Claim File (Request)
                              • Used to resend the Claim file, or to manually download reports.
                              • If used for downloading reports, and there is no Claim file, then the 
                                 following message will display: No claims file found. Nothing will be 
                                 uploaded.
                              • This will be followed by a window saying, ‘Downloading Reports – 
                                 Please Wait’.
          • Viewer Filters:
                    • EMC Destination – No change
                    • From/To – No change
                    • File Type check boxes – Some labels updated, but no change to functionality
                              • EMC Claims File (837) – Previously 'EMC Claim Files (837)'
                              • EMC Report (EMC) – Previously 'EMC Reports'
                              • Remittance (835) – Previously '835 Remittance (ERA)'
                              • Remittance Report (RMT) – Previously 'Remittance Reports'
                              • File Acknowledgement (999) – Previously 'File Acknowledgments 
                                 (999)'
                              • Claims Acknowledgement (277) – Previously 'Claims 
                                 Acknowledgements (277)'
                              • Other Reports (TXT) – No change
                    • View/Requeue button – No change
                    • Raw file check box – No change
                    • Export button – No change
                    • Batch/Filename field – No change
                    • Search button – No change

 X (4/20/2022) Ledger >Charge Window > Co-Pay For Office Visits Only

• The patient Co-Pay will only be posted against Office Visits starting with '992'. 
• This is also the only time that the 'Last Service' date in the 'Account Responsible' section 
   of the Demographics will be updated.

 X (4/7/2022) Ledger >Charge Window > POS Field > Telehealth Place of Service

• 'Effective January 1, 2022, POS code 02 will be revised, and a new POS code 10 will be 
   created. When providing telehealth services to patients in their own homes, providers 
   will start using POS code 10 and stop using POS code 02.
   POS code 10 does not apply to patients who are in a hospital or other facility where the 
   patient receives care in a private residence, such as a nursing home or assisted living 
   facility. In those situations, psychologists will continue to use POS 02.'
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• POS 02: Telehealth Provided in Patient's Home
          • Descriptor: The location where health services and health related services are
             provided or received through telecommunication technology. Patient is not located
             in their home when receiving health services or health related services through 
             telecommunication technology.

• POS 10: Telehealth Provided Other in Patient's Home
          • Descriptor: The location where health services and health related services are
             provided or received through telecommunication technology. Patient is located in
             their home (which is a location other than a hospital or other facility where the 
             patient receives care in a private residence) when receiving health services or 
             health related services through telecommunication technology.

 X (12/7/2021) Look-up Tables >Financial > Fee Tables > ADDED: Sub-Menu

• Under Financial, the new sub-menu 'Fees' was added.

 X (12/17/2021) Look-up Tables >Financial > Fee Tables > Moved To New Sub-
Menu

• The following tables were moved under the new 'Fees' sub-menu for better usability:
          • Category Codes (Previously 'Fee Category Codes')
          • Posting Groups (Previously 'Fee Posting Groups')
          • Group Rules (Previously 'Fee Group Rules')
          • Services
          • Radiology (Advantage product specific table)
          • Miscellaneous

 X (12/17/2021) Look-up Tables >Financial > Fee Tables > NEW Fee Table Design: 
1. Introduction

• The following Fee tables have been updated with a new design for more flexibility.
          • Miscellaneous
          • Radiology (Advantage product specific table)
          • Services
• The 'Plans' table was also updated to accommodate for the new design changes.

• Options Screen
          • Upon selecting an updated table, it will now open the 'X Options' screen, where 'X' 
             is the name of the Fee table that was selected. Example: Service Options.
          • This screen is similar to the 'Fee Schedule Descriptions' in the legacy tables.
          • A new 'Display Order' allows control of the order of entries in the table.
          • The 'Place of Service' and 'Type of Service' will now display the full description, and
             not just the code.
          • The new 'Schedule' command opens the 'X Fee Schedule: Standard' screen, where 
             'X' is the name of the Fee table that was selected. Example: Service Fee Schedule:
             Standard.

• Standard Schedule
          • If updating from a previous version, the software will convert the first Fee 
             Schedule in the legacy table (usually Self Pay) to the 'Standard' schedule.
          • The table MUST contain a Fee Schedule with 'Standard' as the Name, as there is 
             specific programming looking for that Name.
          • Identifying your Standard Fee Schedule:
                    • If you use the ‘Commercial’ column for payors without a contracted fee 
                       schedule; and this is your starting point for building fee schedules for 
                       contracted payors, this is your ‘Standard’ Fee Schedule.
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                    • If your practice is out of network, and patients are expected to pay the 
                       office in full and file their own insurance, then the ‘Self Pay’ column is your 
                       ‘Standard’ Fee Schedule. 

• Other Fee Schedules
          • All other Fee Schedules will be converted with the column number that was 
             assigned in the legacy table.
          • The 'Goto' command will still be used to move to other Fee Schedules.
                    • The legacy 'Back' and 'Next' commands are no longer needed.

• Creating a Fee Schedule
          • Duplicate command
                    • Use this to create a new Fee Schedule that contains all of the same 
                       information as an existing Fee Schedule.
                    • Use 'Goto' to find the original Fee Schedule, then click 'Duplicate' to make a 
                       copy and assign a name to the new one.
          • Schedule command
                    • This opens the 'X Fee Schedules' table, where 'X' is the name of the Fee 
                       table that was selected. Example: Service Fee Schedules.
                    • Here you can add a new Fee Schedule Name, and once saved, the new Fee 
                       Schedule will be available.
                    • A new option for 'Inherit Fee Schedule' displays a list of the existing Fee 
                       Schedules/Price Groups to copy from.
                              • If left blank, the new Fee Schedule will be created, and the following 
                                 fields will be left blank:
                                        • Amount
                                        • Ins. Paid
                                        • Allowed
                                        • Cost
                                        • CPT Code
                                        • Modifier #1
                                        • Modifier #2
                              • If an existing Fee Schedule/Price Group is selected, the new Fee 
                                 Schedule will be created, and all Fee information will be displayed 
                                 from the selected one.
                                        • If the user edits the Amount, Ins. Paid or Allowed fields on the
                                           NEW Fee Schedule, they will save with the new changes.
                                        • If these fields are not edited, they will 'Inherit' and display the
                                           values that are in the Fee Schedule that is listed in the 
                                           'Inherit Fee Schedule' field.
                                        • This is a HUGE help when updating amounts in the future.
                                                  • Standard Fee Schedule is set as the one to Inherit 
                                                     from on 5 other Fee Schedules.
                                                  • Change the Amount on the Standard Fee Schedule, 
                                                     and that updated value will display on all 5 other Fee 
                                                     Schedules.
                                                  • No longer a need to go to the other 5 and update the 
                                                     Amount as well.
                              • See the following topics for complete details:
                                        • Look-up Tables > Financial > Fee Tables > NEW Fee Table 
                                           Design: Pricing Schedule Screen
                                        • Look-up Tables > Financial > Fee Tables > NEW Fee Table 
                                           Design: Fee Schedules Table
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• Starting and Ending a Fee Schedule
          • The new 'X Fee Schedules' table allows the user to enter a Start/End date to 
             control when a Fee Schedule is available to use.
          • Using the 'Start' and 'End' dates:
                    • The 'Start' date:
                              • Controls when the Fee Schedule will become available to use.
                    • The 'End' date:
                              • Controls when the Fee Schedule is no longer available to use.

• Hiding Individual Entries on Specific Fee Schedules
          • The 'Options' screen displays all charges that you post in your practice.
          • If some of those charges are not available for a particular Price Group, they can be
             hidden on that Fee Schedule.
          • Any entries that are marked with 'Hide'=Y will not display when posting charges 
             for a patient with a Payor connected to the specified Fee Schedule.
          • Hiding an entry:
                    • Use the 'Goto' command to find the Fee Schedule.
                    • Find the charge entry that you want to Hide, edit and set 'Hide'=Y.
                    • The 'Hide' command is also available at the top, and can be used if multiple 
                       items need to be hidden.

• How Does Everything Connect?
          • Fee Schedules table (new table)
                    • This is where Names are assigned to Fee Schedules.
                    • The first Fee Schedule in the legacy table will be converted to “Standard”.
                    • The rest of the Fee Schedules will be converted with the number that was 
                       assigned to them in the legacy table. Example: Column 2, Column 3 etc.
                    • If the legacy table had 10 Fee Schedules, there will be 10 entries.
          • Fee Schedules (new table)
                    • This is where fees are assigned to the charges.
                    • The header at the top will display the Name of the Fee Schedule from the 
                       Fee Schedules table (see above).
          • Plans table (existing table)
                    • This is where the Plan is mapped to the Fee Schedule.
                    • The headers now read 'Service Fee Schedule' and 'Material Fee Schedule'.
                    • If the legacy table contained a '1' under either of the headers, it will now 
                       say 'Standard'.
                    • If the legacy table contained a number greater than '1', that number will 
                       display with the word “Column” in front of it. Example: Column 2.
                    • Since multiple Plans could be pointed to the same number, there may be 
                       several Plans that display 'Column 2'.

• Do I Need to Rename Anything?
          • If in the legacy table your 'Standard' Fee Schedule was number 2, then you will 
             need to rename 'Standard' to match what your legacy table had set as number 1.
          • Next rename 'Column 2' to 'Standard'.
          • The Plans table will now display that change.
          • It is NOT mandatory for you to rename anything else for this functionality to work.
          • You may use this as an opportunity to create new names for your existing Fee 
             Schedules. Example:
                    • 'Column 3' could be renamed to 'Commercial'.
                    • Once that change is made, in the Plans table, any Plan that had 'Column 3' 
                       connected to it will now display 'Commercial'.
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KNOW BEFORE YOU GO
• The following areas have been updated to use the new Fee Table Design:
          • Exam > Fees command
          • Ledger > Miscellaneous command
          • Ledger > Mult command
          • Ledger > Radiology command (Advantage product specific table)
          • Ledger > Service command

 X (4/28/2022) Look-up Tables >Financial > Fee Tables > NEW Fee Table Design: 2. 
Options Screen

• Upon selecting an updated table, it will now open the 'X Options' screen, where 'X' is the 
   name of the Fee table that was selected. Example: Service Options.
• This screen is similar to the 'X Fee Schedule Descriptions' in the legacy tables.
          • It includes general information about an entry; it is not Plan/Fee Schedule specific.
          • This is where you Add new entries, Edit or Delete existing entries and assign 
             general information.

• Table Commands
          • Search
                    • Use the Search icon to quickly perform an alphabetical search of your 
                       choice of fields in the table.
                    • Select Field to Search and click OK.
                    • Accept the default 'Post Code' or open the drop-down list to search the 
                       contents of the 'Name' field.
                    • Enter your search characters and click OK.
                    • We recommend that you perform a search prior to adding new records to a 
                       look-up table to confirm the entry doesn't already exist. 
          • Add
                    • Add a new Description/Name to the bottom of the table.
                    • You may only Add on the Options screen.
                    • Use the 'Display Order' on the Editing window if you would prefer to place 
                       the new table entry at a specific spot, rather than at the bottom.
          • Edit
                    • Modify the highlighted entry.
          • Delete
                    • Permanently remove the highlighted charge. 
                    • The following prompt will display: Are you SURE you want to Delete 
                       highlighted item AND ALL Detail entries associated with it?
                    • Click 'Yes' to delete the highlighted entry (there is no UNDO).
                    • You may only Delete on the Options screen. 
          • Print
                    • Generates a Crystal Report to the screen that can be saved, exported or 
                       printed.
                    • The report is generated for the table that it was selected to print from, and 
                       that name will display across the top; Example: Fee Schedule for Services.
                    • The data includes information from the Options and the Fee Schedules; All 
                       Schedules, All Plans.
                    • Fee Schedule(s) by Name and Associated Financial Plans
                              • The table at the top will display the Fee Schedule name, followed by 
                                 the Financial Plans that are attached to that Fee Schedule.
                              • Example: Fee Schedule: Medicare
                                        • Medicare
                                        • Medicare DME
                                        • RR Medicare
                    • Charges are listed by Post Code, followed by the Detail Information.
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                    • Header:
                              • These items are found on the 'Options' screen, and are global for all 
                                 Fee Schedules:
                                        • PostCode – Charge Post Code
                                        • Description – Charge Description
                                        • Cat. Code-Category – Charge Category Code or description
                                        • POS Code-POS – Charge Place of Service Code or description
                                        • Units – Default Charge Units
                                        • TOS Code-TOS – Charge Type of Service Code or description
                    • Detail Information:
                              • These items are found on the individual 'Fee Schedule' screens, so 
                                 data may vary per line:
                                        • Fee Schedule Name
                                        • Ins. Code – Charge Billing Code 
                                        • Modifiers – Modifiers used for billing Charge
                                        • Tax – Taxable Y/N
                                        • Cost – Cost to the practice for Charge
                                        • Charge – Usual & Customary Fee for Charge
                                        • Ins Paid – Defined Insurance Paid Amount for Charge
                                        • Allowed – Defined Allowed Billing Amount for Charge
          • Schedules
                    • Opens the 'Pricing for X Fee Schedule: Standard' screen, where 'X' is the 
                       name of the Fee table that was selected. Example: Pricing for Service Fee 
                       Schedule: Standard)
                    • Standard Schedule
                              • If updating from a previous version, the software will convert the 
                                 first Fee Schedule in the legacy table (usually Self Pay).

• Add a New Entry to the Table
          • Use the 'Add' command to open the 'Fees Editing' window, and complete the fields.
          • Display Order
                    • You can assign a number between 1-999998 to control where this item 
                       appears in the drop-down list when posting charges on the Ledger.
                    • Upon update to version 12.5, all entries will be assigned a 'Display Order' 
                       in increments of 20. Example: 20, 40, 60 etc.
                    • This allows the user to add new entries with 'Display Order' numbers 
                       between those items. Example: 21, 22, 23 etc.
          • Start
                    • Availability Start date for this entry.
                    • If set to a date in the future, this entry will not be able to be charged out 
                       from the Exam until that date.
                    • The entry will not display in the drop-down at the Ledger until that date.
          • End
                    • Availability End date for this entry.
                    • If set to a date in the past, this entry will not be able to be charged out 
                       from the Exam.
                    • The entry will not display in the drop-down at the Ledger.
          • Post Code
                    • Used for automated Exam posting and as a Ledger shortcut.
                    • Post Codes are used by smart scripts throughout the EHR, and as a Ledger 
                       posting shortcut in combination with the F8 function key.
                    • Each one must be unique, and a maximum of 5 characters.
                    • Match the Insurance billing code, or use any combination of letters and 
                       numbers. Avoid special characters such as $!?.
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                    • Be sure to check with Compulink before changing an established Post Code 
                       to avoid issues posting exam charges.
          • Name
                    • Description for the charge.
                    • Charge fields were increased, so you no longer have to enter '$n' at the end
                       of the description for any charges over $9999.99.
          • Units
                    • Units or days associated with charge; defaults to 1, but may be changed.
          • Place of Service 
                    • Place where charge was provided. Select from drop-down.
                    • The 'Select Item' window displays the Code and the Description.
          • Type of Service
                    • Type of Service that was performed. Select from drop-down.
                    • The 'Select Item' window displays the Code and the Description.
          • Category
                    • Sub-classification on financial reports. Select from drop-down.

• Fields no longer used in the new table structure
          • RVU
                    • This field is internally maintained by Compulink.
          • Diag List
                    • Field retired.

 X (4/28/2022) Look-up Tables >Financial > Fee Tables > NEW Fee Table Design: 3. 
Pricing Schedule Screen

• From the 'X Options' screen, click 'Schedules' to access the 'X Fee Schedule: Standard' 
   screen, where 'X' is the name of the Fee table that was selected. Example: Service Fee 
   Schedule: Standard.

• Table Commands
          • Search
                    • Use the Search icon to quickly perform an alphabetical search of your 
                       choice of fields in the table.
                    • Select Field to Search and click OK.
                    • Accept the default 'Post Code' or open the drop-down list to search the 
                       contents of the 'Name' field.
                    • Enter your search characters and click OK.
          • Edit
                    • Modify the highlighted entry.
          • Delete – In Development.
          • Print
                    • Generates a Crystal Report to the screen that can be saved, exported or 
                       printed. (Request)
                    • The report is generated for the table that it was selected to print from, and 
                       that name will display across the top; Example: Fee Schedule for Services.
                    • The data includes information from the Fee Schedule that is displayed when
                       the Print command is selected.
                    • Fee Schedule(s) by Name and Associated Financial Plans
                              • The table at the top will display the Fee Schedule name, followed by 
                                 the Financial Plans that are attached to that Fee Schedule.
                              • Example: Fee Schedule: Medicare
                                        • Medicare
                                        • Medicare DME
                                        • RR Medicare
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                    • Charges are listed by Post Code, followed by the Detail Information.
                    • Header:
                              • These items are global for all Fee Schedules:
                                        • PostCode – Charge Post Code
                                        • Description – Charge Description
                                        • Cat. Code-Category – Charge Category Code or description
                                        • POS Code-POS – Charge Place of Service Code or description
                                        • Units – Default Charge Units
                                        • TOS Code-TOS – Charge Type of Service Code or description
                    • Detail Information:
                              • These items are found on the individual 'Fee Schedule' screen.
                                        • Fee Schedule Name
                                        • Ins. Code – Charge Billing Code 
                                        • Modifiers – Modifiers used for billing Charge
                                        • Tax – Taxable Y/N
                                        • Cost – Cost to the practice for Charge
                                        • Charge – Usual & Customary Fee for Charge
                                        • Ins Paid – Defined Insurance Paid Amount for Charge
                                        • Allowed – Defined Allowed Billing Amount for Charge
                              • If you are using the 'Inherit' functionality, the report will only display 
                                 the Charge lines that have been edited, and the 'Inherited' field 
                                 unchecked.
          • Goto
                    • Used to move between the Service Fee Schedules.
                    • Goto > Fee Schedule by Name
                              • Quickly access Fee Schedules you know the Name for.
                              • Opens the 'Select Fee Schedule' window that displays both the 
                                 'Name' and 'Inherited from' values.
                              • Select a Fee Schedule to Goto/Jump to.
                    • Goto > Fee Schedule by Plan
                              • Quickly access Fee Schedules that are mapped to a specific Plan.
                              • Opens the 'Select Plan' window that displays the items from the 
                                 Financial Plans table.
                              • Select a Plan to Goto/Jump to its assigned Fee Schedule.
          • Schedule
                    • Opens the 'X Fee Schedules' screen, where 'X' is the name of the Fee Table 
                       that was selected. Example: Service Fee Schedules.
                    • See the following topic for details on this table: Look-up Tables > Financial 
                       > Fee Tables > NEW Fee Table Design: Fee Schedules Table.
          • Test
                    • Gives you the expected Ledger Posting results of a highlighted charge.
                    • You will be prompted to enter the expected insurance payment percentage 
                       (your Medicare Fee Schedule will default to 80%).
                    • The 'Ledger Posting Expected Results' window displays the following results 
                       expect to post, based upon the setup:
                              • Amount
                              • Adjustment (Contractual)
                              • Patient Due
                              • Insurance Due
          • Export
                    • Send the contents of this table to a CSV file that may be modified in a 3rd 
                       party program such as Microsoft Excel.
                    • This feature has been enhanced from previous version to be more user 
                       friendly. (Request) 
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                    • Click 'Export' and you will see 'Export data to FeeScheduleX.CSV 
                       complete!". ('X' is the name assigned to the Fee Schedule displayed).
                       Example: Export data to FeeScheduleMedicare.CSV
                    • This is the file name you will open and modify in Excel. 
                    • NOTE: This is only used for Exporting existing Fees to edit, not for adding 
                       new Fees to Import. The number of records Imported, must match the 
                       number of records Exported.
          • Import
                    • Imports a comma delimited file into the displayed table.
                    • Click 'Import' and a prompt 'Select YES to Confirm Import of 
                       FeeScheduleX.CSV' offers 'Yes', 'No' or 'Cancel'.
                    • Yes will bring the contents of the CSV file into your table.
                    • NOTE: This is only used for Importing the Fees that were Exported and 
                       edited, do NOT add new Fees to the CSV file for Importing. The number of 
                       records Imported, must match the number of records Exported.
          • Filter
                    • Used to control which table entries are displayed.
                    • Off – Select to display ALL table entries; this is the default.
                    • UnHidden – Select to display entries that are not marked 'Hide'=Y.
          • Duplicate
                    • Create a new Fee Schedule with a new Name; similar to the 'New' command
                       in the legacy table.
                    • Click 'Duplicate' and you will see 'Select YES to confirm Duplication!'
                    • The 'Duplicate Fee Schedule' window opens for you to 'Enter Name of NEW 
                       Fee Schedule' and click 'OK'. Click 'Cancel' to cancel duplication.
                    • A copy of the displayed Fee Schedule is made and assigned the NEW Fee 
                       Schedule Name that was entered.
                    • Use 'Duplicate' to establish different levels of pricing in your Charge tables.
          • Hide
                    • Places you into record <Hide> mode. 
                    • Double click on a table entry to toggle Hide from 'N' to 'Y'. 
                    • This entry will no longer appear in the table drop-down 
                    • Click 'Hide' again to stop.

• Editing an Entry in the Table
          • The display across the top of the table includes the item 'Inherited'.
                    • This is not an editable field.
                    • A check will display in the box next to the entry if the Fee Schedule is 
                       assigned an 'Inherit Fee Schedule' in the Fee Schedule table.
                    • This entry will Inherit/Display the Fees established in the designated 'Inherit
                       Fee Schedule'
          • Use the 'Edit' command to open the 'Fee Schedule Editing' window for the 
             highlighted charge, and complete the fields.
          • Hide
                    • Used to Hide this entry and prevent posting for this Fee Schedule. 
                    • Set to 'N' to make this entry available on the drop-down for posting.
                    • Set to 'Y' to prevent it from displaying on the drop-down for posting.
          • Amount
                    • The Usual & Customary fee charged to the patient for this entry.
                    • Charge fields were increased, so you no longer have to enter '$n' at the end
                       of the description for any charges over $9999.99.
                    • Upon update to version 12.5, the software will calculate any existing entries
                       with the '$n', and place the correct Amount in the table.
          • Insurance Paid

Compulink Healthcare Solutions | 1100 Business Center Circle | Newbury Park, CA 91320 | 805.716.8677 .
elearning@compulinkadvantage.com | www.compulinkadvantage.com              11



KNOW BEFORE YOU GO
                    • A flat fee expected from the carrier.
                    • Leave blank if Insurance is reimbursing on a percentage basis.
                    • Any difference between 'Amount' and 'Insurance Paid' is added to the 
                       Responsible balance.
          • Insurance Allowed
                    • Maximum allowable amount (Example: Medicare allowable).
          • Cost 
                    • Cost to the practice for this charge.
          • CPT Code
                    • Insurance Billing Code that identifies this item on a claim.
                    • Charges without a CPT Code will not bill to Insurance.
                    • If special circumstances require you to bill negative charge amounts on an 
                       Insurance claim, enter CPT Code ZZZZZ.
          • Modifier #1
                    • The first Modifier Code that you always want to post with the charge. 
                    • You may also assign Modifiers during the Ledger posting.
          • Modifier #2
                    • The second Modifier Code that you always want to post with the charge. 
                    • You may also assign Modifiers during the Ledger posting.
          • Taxable
                    • Enter 'Y' if entry is Taxable for this Fee Schedule, otherwise enter 'N'.

 X (4/28/2022) Look-up Tables >Financial > Fee Tables > NEW Fee Table Design: 4. 
Fee Schedules Table

• From the 'X Fee Schedule' screen, click 'Schedule' to access the 'X Fee Schedules' screen, 
   where 'X' is the name of the Fee table that was selected. Example: Service Fee 
   Schedules.

• Table Commands
          • Search
                    • Use the Search icon to quickly perform an alphabetical search of your 
                       choice of fields in the table.
                    • Select Field to Search and click OK.
                    • Accept the default 'Name' or open the drop-down list to search the 
                       contents of the 'Inherit Fee Schedule' field.
                    • Enter your search characters and click OK.
          • Add
                    • Add a new Fee Schedule Name to the bottom of the table.
                    • Use the 'Display Order' on the Editing window if you would prefer to place 
                       the new table entry at a specific spot, rather than at the bottom.
          • Edit
                    • Modify the highlighted entry.
          • Delete
                    • Permanently remove the highlighted Fee Schedule Name. 
                    • The following prompt will display: Are you SURE you want to Delete 
                       highlighted item AND ALL Detail entries associated with it?
                    • Click 'Yes' to delete the highlighted entry.
          • Filter
                    • Used to control which table entries are displayed.
                    • Off – Select to display ALL table entries; this is the default.
                    • UnHidden – Select to display entries that are not marked 'Hide'=Y.
                    • Hidden – Select to display entries that are marked 'Hide'=Y.
          • Hide
                    • Places you into record <Hide> mode. 
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                    • Double click on a table entry to toggle Hide from 'N' to 'Y'. 
                    • This entry will no longer appear in the table drop-down 
                    • Click 'Hide' again to stop.
          • Utility
                    • Used to filter the list of items in the table.
                    • Hide All – Mark ALL entries as 'Hide=Y'.
                    • UnHide All – Mark ALL entries as 'Hide='N'.

• Add a New Entry to the Table
          • Use the 'Add' command to open the 'Fees Schedules Editing' window, and complete
             the fields.
          • Display Order
                    • You can assign a number between 1-999998 to control where this item 
                       appears in the drop-down list.
                    • Upon update to version 12.5, all entries will be assigned a 'Display Order' of
                       '999999', but may be changed.
                    • If left with the default, they will display in the order in which they are 
                       entered into the table.
          • Hide 
                    • Used to Hide this entry and prevent posting with this Fee Schedule.
                    • Set to 'N' to make this entry available on the drop-down.
                    • Set to 'Y' to prevent it from displaying on the drop-down.
          • Name
                    • Description for the Fee Schedule.
          • Inherit Fee Schedule 
                    • Displays a list of existing Fee Schedules to display from.
                    • If left blank, the new Fee Schedule will be created, and the following fields 
                       will be left blank:
                              • Amount
                              • Ins. Paid
                              • Allowed
                              • Cost
                              • CPT Code
                              • Modifier #1
                              • Modifier #2
                    • If an existing Fee Schedule is selected, the new Fee Schedule will be 
                       created, and all Fee information will be displayed from the selected one.
                              • If the user edits the Amount, Ins. Paid or Allowed fields on the NEW 
                                 Fee Schedule, they will save with the new changes.
                              • If these fields are not edited, they will 'Inherit' and display the 
                                 values that are in the Fee Schedule that is listed in the Inherit Fee 
                                 Schedule' field.
                              • This is a HUGE help when updating amounts in the future.
                                        • Standard Fee Schedule is set as the one to Inherit from on 5 
                                           other Fee Schedules.
                                        • Change the Amount on the Standard Fee Schedule, and that 
                                           updated value will display on all 5 other Fee Schedules.
                                        • No longer a need to go to the other 5 and update the Amount 
                                           as well.
          • Start
                    • vailability Start date for this entry.
                    • Defaults to blank; if left blank, the entry is immediately available.
                    • If set to a date in the future, this entry will not be available until that date.
          • End
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                    • Availability End date for this entry.
                    • Defaults to blank; if left blank, the entry is immediately available.
                    • If set to a date in the past, this entry is no longer available.

 X (3/15/2022) Look-up Tables >Financial > Plans > Table Updated

• The table was updated for the new Fee Table design.
• This is where the Plan is mapped to the Fee Schedule.
• The headers now read 'Service Fee Schedule', 'Miscellaneous Fee Schedule' and 
   'Radiology Fee Schedule' (product specific).
          • If the legacy table contained a '1' under either of the headers, it will now say 
             'Standard'.
          • If the legacy table contained a number greater than '1', that number will display 
             with the word “Column” in front of it. Example: Column 2.
          • Since multiple Plans could be pointed to the same number, there may be several 
             Plans that display 'Column 2'.

• Adding/Editing a record
          • When adding a new record, or editing an existing one, the 'Plan mapping to Fee 
             Schedules Editing' window now displays the new header description, and contains 
             a drop-down to access the Fee Schedules table to select from.
                    • If the Service Fee Schedule is left empty, the software will automatically use
                       the ‘Standard’ Fee Schedule.
                    • If there is no Fee Schedule named ‘Standard’, and this field is left empty, 
                       the user will receive the following message when accessing the Ledger, and 
                       when attempting to post charges: Unable to Locate “Standard” Fee 
                       Schedule for Services!

• Location Specific Pricing Override and Filtering
          • Location specific sub-folders are no longer needed in the Advantage product folder.
          • When adding 'Detail' to the highlighted Plan, a new 'Location Group Plan/Fee 
             Schedule Mapping Editing' window opens.
          • Hide – Used to Hide this entry and prevent this mapping from being used.
                    • Set to 'N' to make this mapping available for posting for the specified 
                       Location Group and Fee Schedules for this Plan.
                    • Set to 'Y' to prevent it from being used for posting.
          • Location Group – The Location Group assigned to the specified Fee Schedules for 
             this Plan.
          • Service Fee Schedule – The Service Fee Schedule assigned to the specified Plan 
             and Location Group.
          • Misc/Material Fee Schedule – The Misc/Material Fee Schedule assigned to the 
             specified Plan and Location Group.
          • Radiology Fee Schedule – The Radiology Fee Schedule assigned to the specified 
             Plan and Location Group. (Advantage product specific)

 (3/17/2022) WebReg >Web Reg > Changes

• Basic Information:
          • In Version 12.5, the current ‘Patient Registration Suite’ is retired, and the process 
             is moved into PracticeWatch and the core Advantage software.
          • This allows Compulink to eliminate the old service completely, eliminate the need 
             for a 2nd service to be installed and provides an easy way to do updates for future
             enhancements and/or security needs.
          • When the practice is updated to 12.5, the old service will no longer be able to pick 
             up registrations, so the new PracticeWatch function will pick them up.
                    • They can also be manually picked up with the new Patient Utility > Web 
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                       Registration Refresh.

• Locally installed software:
          • The legacy Patient Registration service software resides on the C drive of each 
             practice’s server.
          • This prevents Compulink from automatically stopping it and uninstalling it during 
             the update to 12.5.
          • Once the practice updates to 12.5, the software will block the legacy program from
             being able to connect to the Compulink server.
          • This allows the practice to uninstall and remove the service at their convenience.
                    • This can be done at any time, as it does not impact anything in the 
                       Advantage software, or prevent the new function from running.

• Behind-the-scenes changes:
          • The method of getting the registration data from the website.
          • Getting that data into the databases within the Advantage software, and displaying
             it in the Web Reg menu.
          • PracticeWatch Interval Processing:
                    • PracticeWatch now picks up the registrations that are pending, and imports 
                       them into the registration databases automatically.
                    • As long as it is running, the program will download all available registrations
                       every 5 minutes.

• Changes at the practice:
          • Nothing changes regarding the basic functionality of adding or updating patient 
             Web Registration data into the Advantage software.
                    • The ‘Web Reg’ command in the following areas still work the same:
                              • Patient
                              • Insurance
                              • Referrals
                              • Exam
          • New Refresh Utility
                    • The practice does have a new option on the Patient screen: Utility > Web 
                       Registration Refresh.
                    • This allows the user to trigger the software to download any new 
                       registrations that might not have been downloaded yet by PracticeWatch.
                    • It pulls the information into the Web Reg list on the Patient screen.
                    • Clients using kiosks in the office no longer have to wait for the timed 
                       interval to pass for the patient to display on the list; they simply select to 
                       Refresh once the patient has submitted their registration.
                    • This option was not available in the legacy service.
          • Multiple websites
                    • If your practice has more than one website (English/Spanish, Child/Adult, 
                       etc), you will need to contact Compulink Support to assist with configuring 
                       your software to pick up the registrations from the additional sites.

Hot Topics
 X (3/16/2022) Documents > NSA Documents

• These documents are delivered with Version 12.5 and greater; and available upon request
   from Compulink Support.
• See your product Content Catalog for detailed information on the following:
          • NSA BillingProtectionForm
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                    • The Surprise Billing Protection Form document describes the Federal 
                      patient/client protections against unexpected medical bills.
          • NSA GoodFaithEstimate
                    • The Good Faith Estimate for Services and/or Products provides full 
                      transparency to office fees.
          • NSA RightsProtectionsSurpriseBills
                    • The No Surprises Act: Your Rights and Protections Against Surprise Medical 
                       Bills document is an overview of the ruling.
                    • The No Surprises Act requires this information be publicly displayed on your
                       website and in the practice.
          • NSA RightsProtectionsSurpriseBillsBlank
                    • Same as the document above, but does NOT merge patient data.

 X (3/15/2022) Documents > No Surprises Act (NSA)

• The No Surprises Act (NSA) protects patients from surprise medical bills in situations 
   where they can’t easily choose a provider in their health plan’s network. 
• Compulink provides a 'starter set' of NSA documents that can be used to educate your 
   patients about their protections under the NSA, and provide good faith estimates.
• These OpenOffice/LibreOffice documents are designed to merge your practice and patient 
   information, and allow the patient to electronically sign, where appropriate.
• Use them as is, or customize them to meet your needs using the Patient > Print > Word 
   Processing feature.

 (4/12/2022) Exam Command (Fees) > Default Department

• This is not a new feature, but just a reminder of an existing one.
• When posting charges from the Exam, if you would like to default the Dept field, you can 
   set up the Environment Variable on the workstation. (Request) 
          • Variable = DEPT
          • Value = Dept ID
• It assigns the DEPT ID to any charges posted from this workstation. 
• This is designed for offices who wish to track Production by Department, but not schedule 
   by specific Department ID.
• Do not populate the Departments table if you will not be scheduling by DEPT ID.
• You will need to type DEPT ID into report options as there will not be a drop-down list.

Education

Education
 (6/20/2022) User-Focused Education > New Reminder

• Each time a user goes into their Education, the date of their last access is recorded.
• Upon accessing the patient demographics, the software will run the following checks:
          • If new Education items exist, check for the latest access date. 
          • If it has been over 14 days from the latest access date, then check for the last 
             time a reminder was displayed.
          • If it has been longer than 30 days since the last reminder was displayed, then 
             display the reminder.
• If a user never goes into their Education, then every 30 days they would get a reminder.
• Reminder message: 
             Click on the Yellow Education icon on the bottom right of your screen for 
             recent/future updates and videos based on your Login Access Rights. When the 
             icon is YELLOW, there is something new to learn!
• There is no longer a reminder upon login of the software. (Request)

 X (4/28/2022) User-Focused Education > Change in Order for Reviewed
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• Once a record has been marked as Reviewed, it will move to the bottom of the list for the
   version that it is listed for.

 (4/19/2022) Video > NEW: Content Catalogs

• The Compulink University course 'Content Catalogs’ was added.
• It can be found under the following Program: A LEARNING TOOLBOX.
• Course Description: Take a tour of the Content Catalogs, our latest education resource 
   available beginning with V12.5.
• Published: 4/14/2022 - Length: 7 Minutes

 (4/19/2022) Video > NEW: User Focused Education in Your Software

• The Compulink University course 'User Focused Education in Your Software’ was added.
• It can be found under the following Program: A LEARNING TOOLBOX.
• Course Description: Education items filtered by your Advantage user profile are delivered 
   to your desktop.
• Published: 4/14/2022 - Length: 4 Minutes

 (4/19/2022) Video > New Version Release Education Resources

• The Compulink University course 'New Version Release Education Resources’ was added.
• It can be found under the following Program: A LEARNING TOOLBOX.
• Course Description: A new Education Resources document is available for Version 12.5 
   and greater.
• Published: 4/14/2022 - Length: 4 Minutes

 (4/19/2022) Video > UPDATED: AWA: Ledger and Insurance Basics

• The Compulink University course 'AWA: Ledger and Insurance Basics’ was updated.
• It can be found under the following Program: ACTIVATE WITH ADVANTAGE FOR NEW 
   CLIENTS.
• Course Description: This course teaches New Clients Insurance and Ledger Basics.
• Published: 4/14/2022 - Length: 23 Minutes

 (4/19/2022) Video > UPDATED: ELearning Tools and Resources

• The Compulink University course 'Elearning Tools and Resources’ was updated.
• It can be found under the following Program: A LEARNING TOOLBOX.
• Course Description: This course provides an overview of the Education page on our 
   Compulink client website, a brief tour of Compulink University and a look into our Online 
   Help file.
• Published: 4/14/2022 - Length: 23 Minutes

 (4/19/2022) Video > UPDATED: V12.5 General WN

• The Compulink University course 'V12.5 General WN’ was updated.
• It can be found under the following Program: ABOUT VERSION 12.5
• Course Description: Review new features and improvements implemented in V12.5
• Published: 4/14/2022 - Length: 15 Minutes

 (4/15/2022) Advantage Online Help Manual > Data Dictionaries

• The following information has been added to several Data Dictionary topics:
   Data fields populated via look-up from another Compulink table (Standard Codes, 
   Location, Provider) or an external source are not available for use in Exam Encounter 
   Favorites. (Request)

 (4/15/2022) Advantage Online Help Manual > Web Registration

• The following information has been added to the Patient Web Registration topic:
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   Devices accessing Web Registration need to run on a compatible and current browser, 
   such as Google Chrome, Microsoft Edge, Mozilla Firefox or Safari. Devices with 
   proprietary browsers (i.e. Amazon Kindle and some other tablets), may not perform as 
   expected. (Request)

 X (4/15/2022) Content Catalogs > NEW Education Item

• Beginning with Advantage Version 12.5, the Documentation Team started publishing 
   Content Catalogs for each product.
• Clients have access to them from the Version Release Notes, Education page, Help file 
   and the Advantage software.
• Catalogs are published with the release of the new Version Release Notes and initial 
   Service Pack documents.
• They contain changes to the following:
          • Exam Layouts
          • Exam Tabs
          • Exam Documents
          • Exam Smart Functions
          • Patient Layouts
          • Patient Tabs
          • Patient Documents
          • Patient Smart Functions

• What is the benefit?
          • The size of the Version Release Notes and Service Pack documents are reduced, as
             these Catalog items are not included.
          • The amount of data that is imported into the User-Focused Education in the 
             Advantage software is also reduced.

 (4/11/2022) Video > NEW: AWA: System And Financial Table Setup V12.5 > 
Greater

• The Compulink University course 'AWA: System And Financial Table Setup V12.5 > 
   Greater' was added.
• It can be found under the following Program: ACTIVATE WITH ADVANTAGE FOR 
   ESTABLISHED CLIENTS.
• Course Description: Learn about System Setup default efficiencies and Financial Tables in 
   this Activate With Advantage course.
• Published: 4/1/2022 - Length: 23 Minutes

 (4/11/2022) Video > NEW: Change Healthcare Customer Portal

• The Compulink University course 'Change Healthcare Customer Portal' was added.
• It can be found under the following Program: BILLING - INSURANCE ACTIVITIES.
• Course Description: Tour the many resources available on the Change Healthcare 
   Customer Portal. Get a bird's eye view of claim activity on the dashboard, work rejections
   and access the Education Center.
• Published: 4/7/2022 - Length: 9 Minutes

 (4/11/2022) Video > NEW: Compulink Update Utility for Payor/Claim Edits

• The Compulink University course 'Compulink Update Utility for Payor/Claim Edits' was 
   added.
• It can be found under the following Program: ADVANTAGE AT A GLANCE.
• Course Description: Use the Compulink Update utility for on-demand downloads of the 
   latest Compulink-maintained Payors and Claim Edits.
• Published: 4/1/2022 - Length: 2 Minutes
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 (4/11/2022) Video > NEW: Creating a Worklist

• The Compulink University course 'Creating a Worklist' was added.
• It can be found under the following Program: ADMINISTRATOR - SETUP & TOOLS.
• Course Description: Review how to create a Worklist in Data Mining.
• Published: 4/1/2022 - Length: 11 Minutes

 (4/11/2022) Video > NEW: EDI Reports & Remittance Viewers

• The Compulink University course 'EDI Reports & Remittance Viewers' was added.
• It can be found under the following Program: EDI - ELIGIBILITY CLAIMS REMITTANCE.
• Course Description: The EDI Report Viewer helps you manage electronic claims 
   submissions, either direct to a Payor or through a clearinghouse, such as Change 
   Healthcare.
• Published: 4/7/2022 - Length: 14 Minutes

 (4/11/2022) Video > NEW: No Surprises Act (NSA) Documents

• The Compulink University course 'No Surprises Act (NSA) Documents' was added.
• It can be found under the following Program: ADVANTAGE AT A GLANCE.
• Course Description: Briefly review documents Compulink has provided to assist your 
   practice in complying with the No Surprises Act.
• Published: 3/31/2022 - Length: 6 Minutes

 (4/11/2022) Video > NEW: OpenOffice Setup

• The Compulink University course 'OpenOffice Setup' was added.
• It can be found under the following Program: OPENOFFICE.
• Course Description: Review how to download and install OpenOffice.
• Published: 4/1/2022 - Length: 4 Minutes

 (4/11/2022) Video > NEW: OpenOffice Word Processing Basics

• The Compulink University course 'OpenOffice Word Processing Basics' was added.
• It can be found under the following Program: OPENOFFICE.
• Course Description: Review duplicating Compulink Owned Letters, adding Logo, accessing
   the Product Folder and creating User Owned Letters. Special instructions provided for 
   Cloud Clients.
• Published: 4/8/2022 - Length: 10 Minutes

 (4/11/2022) Video > NEW: Psych Advantage Workflow for Psychiatrists

• The Compulink University course 'Psych Advantage Workflow for Psychiatrists' was added.
• It can be found under the following Program: ELECTRONIC HEALTH RECORDS.
• Course Description: Documenting a New Patient Intake with Medication Monitoring for 
   Psychiatry/Nurses/Practitioners.
• Published: 4/7/2022 - Length: 13 Minutes

 (4/11/2022) Video > NEW: V12.5 Report Viewer Changes

• The Compulink University course 'V12.5 Report Viewer Changes' was added.
• It can be found under the following Program: ABOUT VERSION 12.5.
• Course Description: See what's new with V12.5 with the EDI Report Viewer.
• Published: 4/1/2022 - Length: 3 Minutes

 (4/11/2022) Video > NEW: What is New Beginning with V12.5

• The Compulink University course 'What is New Beginning with V12.5' was added.
• It can be found under the following Program: ABOUT VERSION 12.5.
• Course Description: Review new features and improvements implemented in V12.5.
• Published: 4/6/2022 - Length: 15 Minutes
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 (4/8/2022) Video > NEW: AWA: System And Financial Table Setup V12.5 > 

Greater

• The Compulink University course 'AWA: System And Financial Table Setup V12.5 > 
   Greater' was added.
• It can be found under the following Program: ACTIVATE WITH ADVANTAGE FOR NEW 
   CLIENTS.
• Course Description: Learn about System Setup default efficiencies and Financial Tables in 
   this Activate With Advantage course.
• Published: 3/31/2022 - Length: 24 Minutes

 (3/25/2022) Video > EDITED: What is New in V12.5 with Financial Fee Tables

• The Compulink University course 'What is New in V12.5 with Financial Fee Tables' was 
   added.
• It can be found under the following Program: ABOUT VERSION 12.5.
• Course Description: Learn about the new updates and improvements made to the 
   Financial Fee tables in V12.5.
• Republished: 2/18/2022 - Length: 7 Minutes

 (3/25/2022) Video > NEW: Insurance Billing Function

• The Compulink University course 'Insurance Billing Function' was added.
• It can be found under the following Program: ABOUT VERSION 12.5.
• Course Description: Explore the Insurance Billing Function, including new options for the 
   EDI Report Viewer introduced with V12.5.
• Published: 3/18/2022 - Length: 8 Minutes

 (3/25/2022) Video > NEW: Ledger: Options Commands

The Compulink University course 'Ledger: Options Commands' was added.
• It can be found under the following Program: ABOUT VERSION 12.5.
• Course Description: All of the commands under the Options menu in the patient ledger 
   will be shown and demonstrated in this course.
• Published: 3/18/2022 - Length: 32 Minutes

 (3/25/2022) Video > NEW: Table Commands

• The Compulink University course 'Table Commands' was added.
• It can be found under the following Program: ABOUT VERSION 12.5.
• Course Description: Learn about the Look-up Table navigation commands using V12.5. 
   This course is a prerequisite to the individual table courses.
• Published: 3/18/2022 - Length: 10 Minutes

 (3/25/2022) Video > Video > NEW: What is Advantage RCM?

• The Compulink University course 'What is Advantage RCM' was added.
• It can be found under the following Program: ADMINISTRATOR – SETUP & TOOLS.
• Course Description: This course provides a brief introduction to AdvantageRCM and 
   includes Daily and Weekly tasks performed by the Compulink RCM Team and your 
   practice.
• Published: 3/18/2022 - Length: 15 Minutes

 (3/21/2022) Video > NEW: AWA: Ledger and Insurance Basics

• The Compulink University course 'AWA: Ledger and Insurance Basics' was added.
• It can be found under the following Program: ACTIVATE WITH ADVANTAGE FOR NEW 
   CLIENTS.
• Course Description: This course teaches New Clients Insurance and Ledger Basics.
• Published: 2/17/2022 - Length: 23 Minutes
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 (3/18/2022) Video > NEW: Fees Tables

• The Compulink University course 'Fees Tables' was added.
• It can be found under the following Program: ABOUT VERSION 12.5.
• Course Description: This course covers the Fees: Category Codes, Posting Groups and 
   Group Rules tables, and how to complete each one.
• Published: 2/24/2022 - Length: 15 Minutes

 (2/25/2022) Video > NEW: AWA: Patient Services and Demographics

• The Compulink University course 'AWA: Patient Services and Demographics' was added.
• It can be found under the following Program: ACTIVATE WITH ADVANTAGE FOR 
   ESTABLISHED CLIENTS.
• Course Description: This course introduces Patient Demographics features to Established 
   Clients. Upon completion, attendees will be able to create and search for a patient record,
   add insurance information and much more.
• Published: 2/24/2022 - Length: 25 Minutes

 (2/25/2022) Video > NEW: AWA: System and Financial Table Setup

• The Compulink University course 'AWA: System and Financial Table Setup' was added.
• It can be found under the following Program: ACTIVATE WITH ADVANTAGE FOR 
   ESTABLISHED CLIENTS.
• Course Description: Learn about System Setup default efficiencies and Financial Tables in 
   this Activate with Advantage course for Established Clients.
• Published: 2/24/2022 - Length: 23 Minutes

 (2/25/2022) Video > NEW: Claims: Setup and Posting Workflow

• The Compulink University course 'Claims: Setup and Posting Workflow' was added.
• It can be found under the following Program: ABOUT VERSION 12.5.
• Course Description: Review key look-up tables associated with claims processing, 
   V12.5/greater. Proper setup of the patient’s insurance record and posting ledger charges 
   complete the workflow.
• Published: 2/24/2022 - Length: 20 Minutes

 (2/25/2022) Video > NEW: MACRA: 2022 QPP Roadmap to Success

• The Compulink University course 'MACRA: 2022 QPP Roadmap to Success' was added.
• It can be found under the following Program: GOVT COMPLIANCE.
• Course Description: We’ll begin with an overview of MIPS & APMs and 2022 reporting 
   options. We’ll define each of the 4 MIPS categories, learn who participates and who is 
   excluded as well as review the various data submission options.
• Published: 2/24/2022 - Length: 32 Minutes

 (2/25/2022) Video > NEW: MACRA: Quality Measures Claims Submission 2022

• The Compulink University course 'MACRA: Quality Measures Claims Submission 2022' was
   added.
• It can be found under the following Program: ABOUT VERSION 12.5.
• Course Description: This course is designed for users submitting Quality Measures 
   through Medicare Part B claims. Learn how the Exam Quality tab connects to your 
   Financial Services table and how to add/update Quality Codes for the current year, 
   V12.5/greater.
• Published: 2/24/2022 - Length: 10 Minutes

 (2/25/2022) Video > NEW: Plans Table

• The Compulink University course 'Plans Table' was added.
• It can be found under the following Program: ABOUT VERSION 12.5.
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• Course Description: The Plan attached to a patient’s record controls how charges post to 
   their Ledger. This course covers the setup and functionality of the Financial Plans table, 
   V12.5/greater.

 (2/25/2022) Video > NEW: PracticeWatch: Automating ToDo Tasks

• The Compulink University course 'PracticeWatch: Automating ToDo Tasks' was added.
• It can be found under the following Program: PRACTICEWATCH.
• Course Description: Learn how to automate your Patient ToDos. Locate patients that 
   require additional work, and Patient Action Items and assign staff to complete the task.
• Published: 2/24/2022 - Length: 9 Minutes

 (2/25/2022) Video > NEW: PracticeWatch: E-Mailing Patients

• The Compulink University course 'PracticeWatch: E-Mailing Patients' was added.
• It can be found under the following Program: PRACTICEWATCH.
• Course Description: Set up E-Mailing Patients with PracticeWatch.
• Published: 2/24/2022 - Length: 8 Minutes

 (2/25/2022) Video > NEW: PracticeWatch: E-Mailing Staff

• The Compulink University course 'PracticeWatch: E-Mailing Staff' was added.
• It can be found under the following Program: PRACTICEWATCH.
• Course Description: Set up E-Mailing Staff with PracticeWatch.
• Published: 2/24/2022 - Length: 8 Minutes

 X (2/23/2022) User-Focused Education > Change in Display Order

• The display order was changed from oldest announcements at the top to the 
   newest/latest announcements at the top.

 (2/16/2022) Video > NEW: AWA: Appointment Setup

• The Compulink University course 'AWA: Appointment Setup' was added.
• It can be found under the following Program: ACTIVATE WITH ADVANTAGE FOR NEW 
   CLIENTS.
• Course Description: This course teaches attendees how to setup and manage 
   Appointment-related Tables.
• Published: 12/17/2021 - Length: 10 Minutes

 (2/16/2022) Video > NEW: AWA: General Table Setup

• The Compulink University course 'AWA: General Table Setup' was added.
• It can be found under the following Program: ACTIVATE WITH ADVANTAGE FOR NEW 
   CLIENTS.
• Course Description: This course teaches Administrators and management staff the basics 
   of General Table Setup.
• Published: 12/17/2021 - Length: 20 Minutes

 (2/16/2022) Video > NEW: CU For The Administrator: Exam Results & Analysis 
Reports

• The Compulink University course 'CU For The Administrator: Exam Results & Analysis 
   Reports' was added.
• It can be found under the following Program: ABOUT COMPULINK UNIVERSITY.
• Course Description: This course will show how to run the Exam Results Report, as well as 
   to be able to further analyze Exam Results.
• Published: 10/29/2021 - Length: 3 Minutes

 (2/16/2022) Video > NEW: Completing The Provider Setup Form
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• The Compulink University course 'Completing The Provider Setup Form' was added.
• It can be found under the following Program: EDI – ELIGIBILITY CLAIMS REMITTANCE.
• Course Description: The Provider Setup Form helps Compulink determine your billing 
   profile. Learn what information is required and how to complete the fields.
• Published: 12/17/2021 - Length: 8 Minutes

 (2/16/2022) Video > NEW: Financial: Service Fee Table V12.5/Greater

• The Compulink University course 'Financial: Service Fee Table V12.5/Greater' was added.
• It can be found under the following Program: ABOUT VERSION 12.5.
• Course Description: Learn how to build and maintain your Financial Services table, which 
   stores all of your billing codes and fees.
• Published: 12/30/2021 - Length: 21 Minutes

 (2/16/2022) Video > NEW: Ledger: Posting Adjustments

• The Compulink University course 'Ledger: Posting Adjustments' was added.
• It can be found under the following Program: LEDGER.
• Course Description: Learn how to post various ledger adjustments using the Adjust or 
   Delete Line Item Pymts commands. This includes how to handle overpayments and $0.00
   adjustments.
• Published: 12/30/2021 - Length: 15 Minutes

 (2/16/2022) Video > NEW: Ledger: Posting Insurance Payments

• The Compulink University course 'Ledger: Posting Insurance Payments' was added.
• It can be found under the following Program: BILLING – INSURANCE ACTIVITIES.
• Course Description: Walk through different scenarios for posting incoming insurance 
   payments, including how to handle $0.00 EOBs.
• Published: 12/23/2021 - Length: 18 Minutes

 (2/16/2022) Video > NEW: Ledger: Posting Responsible Payments

• The Compulink University course 'Ledger: Posting Responsible Payments' was added.
• It can be found under the following Program: BILLING – PATIENT – GUARANTOR.
• Course Description: Learn about each of the Credit>Responsible commands for posting 
   patient/responsible payments to the ledger.
• Published: 12/17/2021 - Length: 12 Minutes

 (2/16/2022) Video > NEW: Ledger: Prepayments and Unapplied Payments

• The Compulink University course 'Ledger: Prepayments and Unapplied Payments' was 
   added.
• It can be found under the following Program: BILLING – PATIENT – GUARANTOR.
• Course Description: Learn how to post Prepayments and distribute Unapplied Payments in
   your patient ledgers.
• Published: 12/23/2021 - Length: 8 Minutes

 (2/16/2022) Video > NEW: Table Setup for Task Management

• The Compulink University course 'Table Setup for Task Management' was added.
• It can be found under the following Program: PATIENT FLOW.
• Course Description: Explore tables created to support the Enterprise Task Management 
   system. Learn what each table is used for and view a demonstration of how to create 
   entries in each.
• Published: 12/10/2021 - Length: 11 Minutes

 (2/16/2022) Video > NEW: What is New in V12.5.0.10 with Financial Fee Tables

• The Compulink University course 'What is New in V12.5 with Financial Fee Tables' was 
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   added.
• It can be found under the following Program: ABOUT VERSION 12.5.
• Course Description: Learn about the new updates and improvements made to the 
   Financial Fee tables in V12.5.
• Published: 12/30/2021 - Length: 7 Minutes

 (2/16/2022) Video > UPDATED: Ledger: Batch Posting

• The Compulink University course 'Ledger: Batch Posting' was added.
• It can be found under the following Program: LEDGER.
• Course Description: Learn how the Batch Posting feature works for posting charges and 
   payments in a batch format in your patient ledgers.
• Re-Published: 1/6/2022 - Length: 8 Minutes

Appointment

Appointment > Commands
 (12/15/2021) Utility > Quote > Fee Looks at Allowed

• The 'Quote' command will now look at the 'Allowed' amount in the selected Fee Schedule, 
   and display that as the Fee.
• Previous versions displayed the 'Amount/Charge' value.

 (4/12/2022) Utility > Reasons > Fields Opened Up

• Users are now allowed to edit the following fields on a Compulink-owned entry: (Request)
          • Duration
          • Color
          • Patient Workflow

 X (4/12/2022) Utility > Table Setup > Sub-Menu Removed

• The sub-menu for Table Setup was removed, and all items were moved under the main 
   Utility menu.
• The list of items under the Utility now display in alphabetical order.

Communication
 (4/26/2022) InBox > New Reminder

• Each time a user goes into their InBox, the date of their last access is recorded.
• Upon accessing the patient demographics, the software will run the following checks:
          • If unread items exist in the InBox, and the status for these items did not change, 
             check for the latest access date. 
          • If it has been over 30 days from the latest access date, then check for the last 
             time a reminder was displayed.
          • If it has been longer than 30 days since the last reminder was displayed, then 
             check to see how long the unread item has actually been sitting in the InBox.
          • If the unread item has been in the InBox for longer than 14 days, then display the 
             reminder.
• If a user never goes into their InBox, then every 30 days they would get a reminder.
• Reminder message: 
             The existence of unread mail in your Advantage InBox is represented by a yellow 
             InBox on the lower right of the screen!
             You currently have communications that have not been reviewed, and have been 
             in your InBox for a minimum of two weeks!
             Simply click on the YELLOW icon to see your pending Advantage Communications.
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 (3/25/2022) InBox > Xfer > New Option

• When using the ‘Xfer’ command, a ‘Select Patient’ window opens to search for the patient 
   to transfer the document to.
• A field for ‘Birth’ was added to give the user the option to search for the patient by date 
   of birth. (Request)

 (4/21/2022) InBox > Xfer > Provider Review Prompt

• When using the ‘Xfer’ command and selecting either Exam Communication or Exam 
   Test/Treatment/Surgery, the following message will now appear: Would you like Provider 
   to Review?
• Select Yes, and the Select Provider window will open to choose a Provider to review.
• Select No, and it will bypass the Select Provider window.

 (11/4/2021) Message(s) Upon Login > License Expiration Updated

• The message that is displayed upon logging into the software if the office License has 
   expired, has been updated.
• The message now displays directions on where to access the 'Update Configuration' 
   utility.
• Updated message: 
          HELLO!
          Your License has been disabled due to missing License Verification
          Select Update Configuration from the System Admin menu under Utility Main menu 
          option!!
          NOTE!! Your License and Your Support Expiration are completely Separate!
          Enter your Login ID to indicate you have read Message:

Customization
 (4/13/2022) Screen Builder > ALL >   Compulink GUI Style

• In previous versions, any tab with Compulink GUI Style checked, would not allow the user
   to make changes to fonts (Ex: size, color, etc).
• Upon update to version 12.5, these items may now be customized, even if the field is still 
   checked. (Request)

 X (1/12/2022) Screen Builder > ALL >   New HoverMenu Option

• All areas of the Screen Builder were updated.
• A NEW option 'HideOnEmpty' was added for the ellipsis HoverMenu on SQL grids.
          • This can be used to hide the 'Caption' from displaying on the ellipsis hover 
             menu if the grid is empty.
• Click on a grid to select it.
• Find the option 'HoverMenu' in the Object Inspector and double click on 
   '(ThoverCollection)' to the right.
• In the 'Collection Editor' window, the new option 'HideOnEmpty' was added.
• Highlight a ThoverCollectionItem' and change the 'HideOnEmpty' to either 'True' or 'False'.
          • When set to 'False', the 'Caption' will display on the grid when hovering over the 
             ellipsis hover menu, regardless if the grid is empty, or has records in it.
          • When set to 'True', the 'Caption' will ONLY display on the ellipsis hover menu if 
             there are records in the grid; it will NOT display if the grid is empty.
• Compulink-Owned screens are in the process of being updated.
          • If the grid is empty, you may only see the option 'Add' available on the menu.

• This new option is also available on panels, but only if the panel contains a SQL grid.
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 (4/6/2022) Screen Builder > Examination >   Options Available

• The following options are available for the user to control on Compulink-Owned layouts:
          • Positive Doc. (Request) 
          • Complete Document (Request) 
          • Progress Note (Request)
          • Auto Communication (this was already available)

Customization > Smart Functions
 (11/11/2021) Smart Function Editor > ALL > New Columns

• All areas of the Smart Function Editor were updated.
• Highlight a Smart Function and click the 'View' command.
• The window will display all of the tabs that contain the highlighted Smart Function.
• New columns 'Hide' and 'Discontinued' were added.
          • Hide – If the tab has the 'Hidden' field checked, that check will display.
          • Discontinued – If the tab was discontinued, the date it was discontinued will 
             display.
• This will save the user time if they need to make a change; they will no longer need to 
   look at all of the tabs on the list in the Screen Builder.

 (2/25/2022) Smart Function Editor > Exam > New Smart Function

• The new Smart Function 'SF.DrugMonitor' was added.
• It can be connected to an ellipsis hover menu or button.
• When triggered, the software will go directly to Appriss® Health, and the user does not 
   have to click the ‘E-Rx’ command and select ‘Monitor’.
• Complete Smart Function:
          Begin
          SF.DrugMonitor;
          End;

Exam

Exam > General Changes
 (4/29/2022) General Changes > Deleting Communications

• If a Communication record has an image attached to it, and that Communication record is
   deleted, the software will also delete the ExamImage record.

 (5/3/2022) General Changes > Injection Billing

• The option to post Injections from the Exam has now been added to all products.
• Enter common injections given in your office into the Services table, and then into the 
   EHR > Treatment > Name table with a matching Post Code.

 X (4/21/2022) General Changes > Place of Service Updated

• If the patient’s Exam Place of Service is blank, upon update to Version 12.5 and greater, 
   the software will automatically assign Office.

 (4/29/2022) General Changes > Provider Dashboard

• The software now supports embedded worklists in the Exam. (Request) 
• This allows the user to create a Provider Dashboard in the Screen Builder for Exam.
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Exam > Display Changes
 (1/12/2022) Display Change(s) > Header > Location Code For ASC

• In the 'Location > Details' table, if the 'ASC' field is set to 'Y', then the Location Code on 
   the top right of the Exam will be highlighted in yellow. (Request)
• This acts as a visual reminder to the user that they are on the patient's ASC record, not 
   their clinic record.

Exam > Commands

Exam > Command (E-Rx)
 (3/31/2022) E-Rx > Command (Change) > PRESCRIBER Information

• In the PRESCRIBER area, the DEA# was moved to the left, and the following were added:
          • Nadean (this is the DEA#2)
          • State License
          • NPI
          • Taxonomy

 (3/31/2022) E-Rx > Command (Change) > Rx Change Request Header Updated

• The header of the Rx Change Request window was updated for requests with type=D.
• If a request comes in for this type, the header on the window will now read: Drug Use 
   Evaluation Rx Change Request.
• Type D = DUE (Drug use Evaluation).
• This may be used to request a prescriber authorize a change to the patient’s current 
   medication therapy, such as a dosing regimen change or an alternative medication that 
   will have fewer or no, adverse effects than the original prescription.

 (5/2/2022) E-Rx > Command (Monitor) > No Medication Required

• There is no longer a requirement to enter a medication prior to using the Monitor option 
   to check for a Narx report. (Request)

 (12/14/2021) E-Rx > Command (Review) > Display Full Name

• If a Medication does not pass Review, the message that displays will now contain the full 
  Medication Name to help identify which one on the screen did not pass.

 (5/31/2022) E-Rx > Command (Screen) > NDC Reminder

• If the medication is missing the NDC Code, the following message will no longer display, it
   will just immediately go into the Drug Search window: Selected drug Missing National 
   Drug Code “NDC”! Please Select Drug from subsequent Drug Search Screen!’ (Request)

 (4/20/2022) E-Rx > Command (Utility) > Vitals Update

• The new option for Vitals Update was added.
• If documented Vitals are required for E-Rx (example: patient under 18), click Utility > 
   Vitals Update to open and record the patient Height and Weight.
• Only needed if documentation was not already entered during the exam process.

 (5/31/2022) E-Rx > Command (Xmit) > Cash Coupon

• All new Rxs will now be sent to the pharmacy with a Rx Cash Coupon for medications paid
   for with cash and not Insurance. (Request) 
• Note: This does not guarantee that it will be applied by the pharmacy on their end.

 (5/31/2022) E-Rx > Command (Xmit) > Compound Drug Error

• The following error will display when attempting to transmit the Medication if the Detail 
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   records have not been added in the table: Compound ingredients cannot be located.

 (12/14/2021) E-Rx > Display > Hover Hint

• When hovering over a Medication record, a hint window will pop up to display the 
   information in the 'Internal Notes' field.

 X (5/26/2022) E-Rx > Mandatory Information > Vitals

• The NewScripts for AdvantageERx now requires the practice to enter Height and Weight 
   for patients under the age of 18.
• Currently there are two options for entering this data into the Exam:
          • The 'Examination' layout contains the 'Hx/Meds' tab with a 'Vitals' panel.
          • There is a 'History Vitals (HiRes)' tab that may be added to any preferred layout, 
             either in Screen Builder (permanent addition), or on-the-fly based on the patient.

Exam > Command (Fees)
 X (12/27/2021) Fees > Posting Update

• When posting charges with the 'Fees' command, the 'EHR Automated Fee Posting' window
   will now access the new Fee tables.

 (4/15/2022) Fees > NDC > Units from Services

• Posting J Codes from the Exam pulls the Units from the Service table. (Request)

 (2/25/2022) Fees > Post > Referral Attached

• If an Episode is connected to the Exam, and a Referral Source is connected to that 
   Episode, when posting charges, the Referral information will automatically default into 
   the charge screen. (Request) 
• This includes the Source, as well as the Authorization#.

Exam > Command (Locate)
(4/22/2022) Locate > Exam > New Column

• The new column Provider was added.
• This will display the Last, First name of the Provider that signed off on the record.
• If more than one Provider signed off, then there will be an entry for each Provider.

Exam > Command (MACRA)
 (2/4/2022) MACRA > Send CCD to Referring Provider Portal > Select Referral

• Standard functionality requires highlighting the Referral Source that you want to send to 
   in the Referral grid, then selecting the command.
• If the current Exam layout does not contain a Referral grid, select 'MACRA', and a 'Select 
   Referral' window will open, displaying all active Referrals connected to the patient; double
   click to select the one you would like to send to. (Request)

Exam > Command (Orders)
 X (4/13/2022) Orders > Assessments/Plans > Diagnosis Mapping

• If a Diagnosis does not have an Assessment or Plan connected to it, nothing will display in
   the Assessments and Plans windows; in previous versions, it displayed all Assessments 
   and Plans. (Request) 
• Blank Diagnosis Mapping record
          • If the software finds a blank Diagnosis Mapping record with Assessments and Plans
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             attached to it, those will show up for ALL Diagnoses.
          • As in the example above, if the Diagnosis does not have a record in the Mapping 
             table, nothing will display; however, if there is a blank Mapping record, 
             Assessments/Plans attached to the blank record will display.
          • If the Diagnosis does have a mapping record, the mapped Assessments/Plans will 
             display, along with the ones that are attached to the blank record.
• Creating a blank Diagnosis Mapping record
          • Right click in the either the Assessments or Plans window and select Diagnosis 
             Mapping.
          • Click Add and when the Assessment/Plan by Diagnosis Editing window opens, just 
             click Save.
          • Highlight the blank record and use Detail > Add to connect the Assessments/Plans.
          • Any that are connected will show up as an option for ALL Diagnoses in the SMART 
             Patient Orders window.

 (4/20/2022) Orders > Diagnoses Window > Done

• After all Diagnoses have been addressed and marked with Done=Y, the SMART Patient 
   Orders window will automatically close.

 (4/20/2022) Orders > Diagnoses Window > Long Desc.

• In the Diagnosis List window, the Long Desc. Will now display, instead of the Short Desc.

 (3/31/2022) Orders > Order Details > Hidden Items Blocked

• If an Order Detail record is marked Hide=’Y’ in the primary look-up table, and it is still 
   connected to an Order Set, it will no longer display when selecting the Order Set.
• Example:
          • Order Detail of ‘CBC’ test is connected to Order Set ‘Blood Tests’.
          • Select ‘Blood Tests’ Order Set, and ‘CBC’ will display under ‘Order Details’.
          • Go to the EHR > Test table and hide ‘CBC’.
          • Go to the Exam and to Orders.
          • Select ‘Blood Tests’ Order Set; ‘CBC’ will no longer display under ‘Order Details’.

 (2/23/2022) Orders > Order Details > Medication

• When adding a Medication via Orders, it will now display the following information in the 
   ‘Plan’ after clicking ‘Save with Orders’.
          • Name
          • Strength
          • Form – new
          • Short SIG - new

 X (5/3/2022) Orders > Order Details > Surgeries

• When adding surgeries to the exam using Orders, the Date defaults to blank. (Request)

 (1/7/2022) Orders > Order Sets > ADDED: *Medications

• The Order Set 'C*Medications' was added with the individual Orders below.
• This is just a sample list that can be made practice specific.
• Medications on sample list:
          • Abilify 2 mg tablet
          • Abilify 5 mg tablet
          • Abilify 10 mg tablet
          • Abilify 15 mg tablet
          • Abilify 20 mg tablet
          • Abilify 30 mg tablet
          • Adderall XR 10 mg Capsule, ER 24 hr
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          • Adderall XR 20 mg Capsule, ER 24 hr
          • Adderall XR 30 mg Capsule, ER 24 hr
          • Ativan 0.5 mg tablet
          • Ativan 1 mg tablet
          • Ativan 2 mg tablet

 (1/7/2022) Orders > Order Sets > ADDED: Common Labs

• The Order Set 'Common Labs' was added with the following individual 
   Orders:
          • CRP, C-Reactive Protein, Quantitative
          • Vitamin D 25 Hydroxy
          • Thyroid Panel
          • Vitamin B12
          • Estradiol Levels
          • Testosterone, Total, serum
          • Magnesium
          • Homocysteine
          • Zinc
          • Celiac Disease Panel
          • MTHFR DNA Analysis
          • Lyme Disease, ISR AB Ts W/Ref to w Blot
          • Glucose – Fasting
          • Insulin – Fasting
          • HgbA1c

 (1/7/2022) Orders > Order Sets > ADDED: Substance Screening Panel

• The Order Set 'Substance Screening Panel' was added with the following individual 
   Orders:
          • Alcohol (Ethanol) Presence-Urine-Screen
          • Amphetamines-Presence-Urine-Screen
          • Benzodiazepines-Urine-Screen
          • Buprenorphine Tox Screen
          • Cocaine Panel
          • Codeine-Urine-Screen
          • Methadone Tox Screen
          • Opiates-Urine-Screen
          • THC-Presence-Urine
          • Urine Drug Screen 12 Panel

 (4/29/2022) Orders > Order Sets > Adding Surgeries

• When adding Surgeries to an Order Set, the Post Code will now display in [ ] behind the 
   Surgery Name.

 (4/21/2022) Orders > Order Sets > Medication

• When adding Detail to an Order Set and selecting Medication as the Order Type, the 
   Select Item(s) window will display the following new items, along with the Name:
          • Dose
          • Units
          • Form

 (4/20/2022) Orders > Order Sets > Multi-Select

• When adding Detail to the Order Set, the Select Items window is now multi-select.
• Adding Detail to an Order Set:
          • Highlight the Order Set and click Detail > Add.
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          • Select the Order Type.
          • In the Select Items window, click the box to the left of all of the items to be added.
          • When done, click anywhere in the blue to save, or click the OK button.
          • All items selected will display at the bottom in the Individual Orders window.

Exam > Command (Print) (General Changes)
 (3/16/2022) Print > Letter > ADDED: See Below

• For details on the item below, please refer to your Advantage Product Content Catalog.

• File Name: NSA BillingProtectionForm
• Name on Document: Surprise Billing Protection Form

• File Name: NSA GoodFaithEstimate
• Name on Document: Good Faith Estimate for Services and/or Products

• File Name: NSA RightsProtectionsSurpriseBills
• Name on Document: No Surprises Act: Your Rights and Protections Against Surprise 
   Medical Bills

• File Name: NSA RightsProtectionsSurpriseBillsBlank
• Name on Document: No Surprises Act: Your Rights and Protections Against Surprise 
   Medical Bills

 (2/23/2022) Print > Letter > EDITED: See Below

• For details on the item below, please refer to your Advantage Product Content Catalog.

• ExamComplete

Exam > Command (Utility)
 (5/19/2022) Supervisor Batch Sign-off > New Option

• The new option Supervisor Batch Sign-off was added to allow a Supervisor to sign off on 
   all of their mid-level staff’s Exam records at one time.
• WARNING: This is not a replacement for monitoring your staff’s work.

• Login IDs Table Setup
          • Supervisor ID field
                    • The Supervisor ID field of the mid-level staff, should be populated with their
                       Supervisor’s Login ID.
                    • If this field is left blank, the software will look at the Supervising Provider 
                       listed in the Exam. This field is product specific.
                    • If BOTH fields are populated, the Supervising Provider in the Exam will be 
                       used.
          • Require Supervisor EHR Sign-off field
                    • This field should be set to N.

• Signing Off
          • When the Supervisor Batch Sign-off option is selected, the software looks for the 
             following items:
                    • The Exam must be dated within the last 30 days.
                    • The ID of the Supervisor that is logged in matches the Supervising Provider 
                       listed in the Exam. OR.
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                    • The ID of the Supervisor that is logged in matches the Supervisor ID in the 
                       Login IDs table connected to the mid-level staff member that already 
                       signed off on the Exam. 
                              • Example: ABC is the mid-level staff that signed off on the Exam. 
                              • In the Login IDs table, XYZ is listed in the Supervisor ID for ABC.
                              • Supervisor XYZ logs into the software and is able to use the Batch 
                                 Sign-off for this mid-level staff.
          • If matches are found, the records are signed off, and the following message 
             displays: Supervisor Signoff Record Count: X (where X displays the number of 
             records signed off).

• Note – The records that will be signed off match the records listed on the worklist: 
   Requires Supervisor Signoff.

 (4/21/2022) Utility > Location/Staff Filtering > Layouts

• The following columns were removed from the table:
          • Height
          • Width
• The following columns were added to the table:
          • Display Order
          • Hide
• Table will now sort by the ‘Display Order’ and not ‘Name’.

 (4/21/2022) Utility > Location/Staff Filtering > Tabs

• The following columns were removed from the table:
          • Height
          • Width
• The following columns were added to the table:
          • Display Order
          • Hide
• Table will now sort by the ‘Display Order’ and not ‘Name’.

Exam > Command (Web Reg)
(4/21/2022) Web Reg >   Layout Selection PopUp

• When accessing the patient Exam, if the patient entered any Exam related information 
   during Registration, the following message will display: Exam Related Registration Data 
   Exists! Exam Record must be created for today before Importing!
• Click OK, and the software will now open the Select Layout window to choose the layout 
   to add for the day.
• Once the layout is loaded, click on the Web Reg command to access the information.

Exam > Layouts

Exam > Layouts (DISCONTINUED)
 (1/7/2022) Layout(s) > DISCONTINUED: 1 Tab Session Note

• This layout was discontinued, as the new 'HiResSessNoteMH' tab can be found on the 
   following layouts:
          • HiRes MH Follow Up
          • HiRes MH Intake
• Upon update to Version 12.5, it will be marked with a 'Discontinued' date.
• Your office may continue to use the layout, but it will no longer be updated with new 
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Exam > Layouts (DISCONTINUED)
   functionality.
• Load the layout and remove the check in the 'Discontinued' field to continue using.

Exam > Layouts (EDITED)
 X (3/9/2022) Layout(s) > EDITED: HiResIntake

• The labels/tab text at the top of the tabs were updated to the following:
          • Tab: HiResCompROSNew
                    • Old label: HiResCompR, New label: Complaint
          • Tab: HiResHistory
                    • Old label: HiResHisto, New label: History
          • Tab: HiResPsychPersonal
                    • Old label: HiResPsych, New label: Psych Hx
          • Tab: HiResSubHx
                    • Old label: HiResSubHX, New label: Substance
          • Tab: HiResMHPE
                    • Old label: HiResPEMHS, New label: MSE/PE
          • Tab: HiResDxPlan
                    • Old label: HiResDxPla, New label: Tx Plan

 X (1/12/2022) Layout(s) > EDITED: MH Intake

• The 'ReviewOfSystems' tab was replaced with the new tab 'ReviewofSystemsNew'.
          • This tab contains the new 'ROS' memo field with an ellipsis hover menu.

 X (1/7/2022) Layout(s) > EDITED: See Below

• The 'ReviewOfSystems' tab was replaced with the new tab 'ReviewofSystemsNew' on the 
   layouts listed below.
• This tab contains the new 'ROS' memo field with an ellipsis hover menu.
• Layouts edited:
          • Med Management w/Treatment
          • Medication Monitoring
          • MH Intake
          • MH Intake w/ROS, HH
          • MH Intake with Addiction
          • Nutrition Assessment
          • Psych Follow Up w/Treatment
          • PsychChildFollowUp w/Trmt
          • PsychChildInitialEval w/Trmt
          • PsychiatricFollowUp
          • PsychiatricInitialEval

Exam > Tabs

Exam > Tabs (ADDED)
 X (1/18/2022) Tab(s) >   ADDED: HiResCompMHNew

• This tab was created to replace the legacy tab 'HiResCompMH'.
• The legacy tab was copied, and the 'ROS' section was updated to the new memo field 
   with options on the ellipsis hover menu.

 (1/7/2022) Tab(s) >   ADDED: HiResCompROSNew

• This tab was created to replace the legacy tab 'HiResCompROS'.
• The legacy tab was copied, and the 'ROS' section was updated to the new memo field 
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Exam > Tabs (ADDED)
   with options on the ellipsis hover menu.

 X (2/24/2022) Tab(s) >   ADDED: PopUpROS

• Tab Name: PopUpROS
• Tab Label: PopUpROS

• This NEW tab contains the individual Review of Systems fields.
• Accessed from the 'Comprehensive ROS' option on the ellipsis hover menu on the new 
   'ROS' memo field.
• Once the individual fields are populated, and the screen is saved, the data will populate 
   the 'ROS' memo field.

 X (1/12/2022) Tab(s) >   ADDED: ReviewofSystemsNew

• Tab Name: ReviewofSystemsNew
• Tab Label: ROS

• This NEW tab is a copy of the 'ReviewofSystems' tab.
          • It contains the new 'ROS' memo field with an ellipsis hover menu.

Exam > Tabs (DISCONTINUED)
 X (1/18/2022) Tab(s) > DISCONTINUED: See Below

• The tabs below were discontinued.
• Upon update to Version 12.5, they will be marked with a 'Discontinued' date.
• Your office may continue to use the tabs, but they will no longer be updated with new 
   functionality.
• Load the tabs and remove the check in the 'Discontinued' field to continue using.

• Tabs discontinued:
          • HiResCompMH
                    • Replaced with the new tab 'HiResCompMHNew'.
          • HiResCompROS
                    • Replaced with the new tab 'HiResCompROSNew'.
          • ReviewOfSystems
                    • Replaced with the new tab 'ReviewofSystemsNew'.

Exam > Tabs (EDITED)
 (3/15/2022) Tab(s) > EDITED: HiResCPsych

• Tab Name: HiResCPsych
• Tab Label: Psych Hx

• The label/tab text at the top of the tab was updated to the following:
          • Old label: HiResCPsych, New label: Psych Hx

 (3/15/2022) Tab(s) > EDITED: HiResChildHx

• Tab Name: HiResChildHx
• Tab Label: Child Hx

• The label/tab text at the top of the tab was updated to the following:
          • Old label: HiResChild, New label: Child Hx

 (3/15/2022) Tab(s) > EDITED: HiResCompROSNew
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Exam > Tabs (EDITED)
• Tab Name: HiResCompROSNew
• Tab Label: Complaint

• The label/tab text at the top of the tab was updated to the following:
          • Old label: HiResCompR, New label: Complaint

 (3/15/2022) Tab(s) > EDITED: HiResDxMHPlan

• Tab Name: HiResDxMHPlan
• Tab Label: Tx Plan

• The label/tab text at the top of the tab was updated to the following:
          • Old label: HiResDxPln, New label: Tx Plan

 (3/15/2022) Tab(s) > EDITED: HiResDxPlan

• Tab Name: HiResDxPlan
• Tab Label: Tx Plan

• The label/tab text at the top of the tab was updated to the following:
          • Old label: HiResDxPla, New label: Tx Plan

 (3/15/2022) Tab(s) > EDITED: HiResHistory

• Tab Name: HiResHistory
• Tab Label: History

• The label/tab text at the top of the tab was updated to the following:
          • Old label: HiResHisto, New label: History

 (3/15/2022) Tab(s) > EDITED: HiResMHPE

• Tab Name: HiResMHPE
• Tab Label: MSE/PE

•The label/tab text at the top of the tab was updated to the following:
          • Old label: HiResPEMHS, New label: MSE/PE

 (1/7/2022) Tab(s) > EDITED: HiResMedicationPsych

• Tab Name: HiResMedicationPsych
• Tab Label: Medication

• Current Medications panel
          • The ellipsis hover menu was updated, and the option 'Common Medications' was 
             added.
                    • When clicked, the 'Select Orders' window will open with a list of commonly 
                       prescribed Medications.
                    • Select all that apply and click 'OK'.
                    • The 'Medication Edit' window will open for the first selected Medication, 
                      and several fields will be auto-populated.
                    • Make any needed changes and click 'Save'.
                    • If more than one Medication was selected, the next 'Medication Edit'
                       window will open to allow for changes.
                    • If the Common Medication is established in the Order with all required fields
                       for submitting the Medication, the 'Medication Edit' window will be 
                       bypassed, and the Medication will automatically be added to the patient 
                       record.
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Exam > Tabs (EDITED)
 (3/15/2022) Tab(s) > EDITED: HiResPsychPersonal

• Tab Name: HiResPsychPersonal
• Tab Label: Psych Hx

• The label/tab text at the top of the tab was updated to the following:
          • Old label: HiResPsych, New label: Psych Hx

 (1/7/2022) Tab(s) > EDITED: HiResSessNoteMH

• Tab Name: HiResSessNoteMH
• Tab Label: Sess Note

• Top left
          • Accomp. By field – This is a new field to document if another person was with the 
             patient in the Exam room.
          • Relationship field – This is a new field to document the relationship of the 'Accomp.
             By' person to the patient.

 (1/7/2022) Tab(s) > EDITED: HiResSessNotePsych

• Tab Name: HiResSessNotePsych
• Tab Label: Sess Note

• Top left panel
          • This new panel referred to as the 'Visit' panel was added for Psychiatrists to 
             document information used for the Coding functionality.
          • The 'Vitals' TabAdd icon can be used to add the 'Vitals' tab to the end of the Exam.

• Diagnosis/Plan panel
          • Billing field – This is a new field to allow for entering a billing override code.
          • Medical Decision Making field – This is a new field to enter the Medical Decision 
             Making level.
                    • Click the label with the Tool icon to open the 'Medical Decision Making 
                       Calculator' window.
                    • Select the options and click 'Assign' to populate the field on the panel.

• Therapy/Treatment panel
          • The 'Progress Notes' field was added, and will display the Participation Notes.

 (3/15/2022) Tab(s) > EDITED: HiResSubHx

• Tab Name: HiResHistory
• Tab Label: History

• The label/tab text at the top of the tab was updated to the following:
          • Old label: HiResSubHX, New label: Substance

 (1/7/2022) Tab(s) > EDITED: Labs

• Tab Name: Labs
• Tab Label: Lab Tests

• Lab Testing Summary panel
          • The 'Lab Order' option on the ellipsis hover menu was updated.
                    • When clicked, it will now open the document selection window to allow 
                       users to select either the 'ExamLabOnlyOrders' document, or the 
                       'ExamLabOnlyOrdersSign' document.
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Exam > Tabs (EDITED)
 (1/12/2022) Tab(s) > EDITED: PopUpIndServicePlan

• Tab Name: PopUpIndServicePlan
• Tab Label: PopUpIndSe

• Frequency field 
          • The option 'PRN' was added to the drop-down.

 (6/20/2022) Tab(s) > EDITED: PopUpMedication

• Tab Name: PopUpMedication
• Tab Label: Medication

• Historical field
          • If a medication is marked ‘Historical’ prior to saving the record, it will no longer 
             display the following message: Medication entered missing National Drug Code 
             “NDC” for Prescribing or Drug Screening! Would you like to Use Drug Search 
             function to update? (Request) 

• Pharmacy field
          • Select from table
                    • You cannot free-type in the field, you must select from the table.
                    • To narrow down the search, click in the field and hit a letter on your 
                       keyboard.
                    • This opens the 'Lookup Search' window for you to enter characters to 
                       search through the table. (Request) 
                    • Example: Enter CVS and click OK to look for all CVS Pharmacies.
                    • The list that displays will only be entries that match the search characters.
          • Pharmacy search
                    • Clicking the drop-down now opens the same Pharmacy Search window that 
                       is used in the E-Prescribe window. (Request) 
                    • All of the same options for searching are available.

 (1/7/2022) Tab(s) > EDITED: Quality Measures MIPS

• Tab Name: Quality Measures MIPS
• Tab Label: QM CQM21

• Quality Measure #48 panel
          • This is a new panel added for 'Uriny Incont: Assmnt of Presnc/Absnc of Urinary 
             Incontinence in Womn Age 65 and Older'.

 (1/7/2022) Tab(s) > EDITED: See Below

• The changes listed below were made on the following tabs:
          • Tab Name: Service Plan > Tab Label: Serv Pln
                    • Location – Bottom right panel
          • Tab Name: Therapy > Tab Label: Therapy
                    • Location – Bottom right panel
          • Tab Name: TreatPln > Tab Label: TreatPln
                    • Top right panel

• Panel (see above for location)
          • Transition Plan label – This label was renamed from 'Urgent Needs'. (Request)

 (3/8/2022) Tab(s) > EDITED: See Below

• The change listed below was made on the following tabs:
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Exam > Tabs (EDITED)
          • Tab Name: HiResCompROSNew > Tab Label: HiResCompR
                    • Location – Medications panel
          • Tab Name: HiResMedicationPsych > Tab Label: Medication
                    • Location – Current Medications panel
          • Tab Name: HiResSessNotePsych > Tab Label: Sess Note
                    • Location – Medications panel
          • Tab Name: MedCheck > Tab Label: MedCheck
                    • Location – Medications panel
          • Tab Name: MedicationPsych > Tab Label: Medication
                    • Location – Medications panel

• Panel (see above for location)
          • The ellipsis hover menu was updated, and the ‘PDMP’ option was added.
                    • When clicked, the software will go directly to Appriss® Health, and the user
                       does not have to click the ‘E-Rx’ command and select ‘Monitor’.
                    • If a report is not found, the following message will display: A Narx Report 
                       for this patient is not available at this time!

Exam > Look-up Tables
 X (12/16/2021) Look-up Tables > Assessment/Plan > By Diagnosis > NEW Staff 

Group Option

• When adding 'Detail' to the highlighted Diagnosis, a new 'Assessment/Plan by Diagnosis 
   Editing' window opens.
          • Hide – Used to Hide this entry so it will not appear as an option for this Diagnosis.
                    • Set to 'N' to display as an option when selecting the Assessment/Plan.
                    • Set to 'Y' to prevent displaying it as an option.
          • Owner – 'C' for Compulink-owned and 'U' for User-owned.
          • Short Description – The Short Description for the Assessment/Plan.
                    • Click the drop-down to open the 'Select Assessment/Plan' to attach to the 
                       Diagnosis.
                    • Upon selection, the 'Type' field will be populated with either 'A' (if an 
                       Assessment was selected) or 'P' (if a Plan was selected).
          • Type – Assessment (A) or Plan (P)
          • Default – Option to default the entry as checked when adding the Diagnosis to the 
             Exam record.
                    • Set to 'N' to display as an option to select when adding the Diagnosis.
                    • Set to 'Y' to default as selected any time the Diagnosis is added.
          • Staff Group – The Staff Group assigned to the specified Assessment or Plan.
                    • If left blank, the entry will display as an option for all users.
                    • If a 'Staff Group' is selected, the entry will only display as an option for 
                       users assigned to the specified 'Staff Group'. (Request)
          • Modified – Internal field updated by the software.

 (1/18/2022) Look-up Tables > EHR > Note > ADDED: See Below

• The following items were added with the Sort of 'CBTHOMEWRK':
          • ACT Exposures Exercise
          • ACT With Choice Exercise
          • Angels and Devils Worksheet
          • Aware of Breathing
          • Big Picture Exercise
          • CBT Learning Log
          • Clouds in the Sky
          • Cognitive Disputation
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Exam > Look-up Tables
          • Cognitive Distortions
          • Costs/Benefits of Change
          • Four Layers of Abstraction
          • Goals for Therapy
          • Graded Hierarchy of Anxiety
          • Layers of Cognition
          • Leaves on a Stream 
          • Linking Feelings and Appraisal
          • Noticing the Thought
          • PACE Activity Exercise
          • Penguin-Based Therapy (PBT)
          • Personal Resilience Plan
          • Personal Strengths/Resources
          • Personal Values
          • Post-Therapy Journal
          • Problem Statements
          • Semantic Satiation
          • Sleep Hygiene Factors
          • Speed Up/Slow Down 
          • Submissive, Assert & Aggress
          • Taming the APE
          • The ABC Form in Functional Anal
          • The Behavioral Experiment
          • The CBT Continuum
          • The CBT Junction Model
          • The CBT Responsibility Chart
          • The CBT Thought Record
          • The Characterization Game
          • The Cross-sectional CBT Model
          • The Longitudinal Assessment
          • The Self-perception Continuum
          • The Time-Traveller's Log
          • The Traffic
          • Theory A-B Exercise
          • Transdiagnostic Model OCD Ws
          • Tuning In Exercise
          • Wheel of Emotions
          • Word Translation
          • Worry – Thinking Time

 (1/18/2022) Look-up Tables > EHR > Note > ADDED: See Below

• The following items were added with the Sort of 'SKILLSTRN':
          • Accepting/Giving Compliments
          • Being assertive
          • Communicating Non-Verbally
          • Introductions
          • Overcoming Telephone Phobia
          • Practicing Active Listening
          • Verbal Communication

 (3/23/2022) Look-up Tables > Encounter Favorites > Collapsible Subgroups 
Added

• The 'Encounter Favorite' table was updated to now allow for creation of collapsible 
   Subgroups.
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Exam > Look-up Tables
• Many of the Compulink-Owned Favorites have been updated to display the new sub-
   groups. (Request)

• Pieces of the Encounter Favorite
          • Encounter Favorites
                    • Upon entry into the table, the list of Encounter Favorites display.
                    • These are considered ‘Headers’, and will display when opening the 
                       Encounter Favorites list for the specified tab in the Exam.
          • Subgroups
                    • The ‘Subgroups’ command opens the ‘Encounter Favorite Groups’ table.
                    • In the Exam, these Groups will display under the Encounter Favorite that 
                       they are connected to.
                    • They are also referred to as ‘Child Encounter Groups’.
          • Parent record
                    • The ‘Parent’ record is the first level in the Encounter Favorite that contains 
                       default values.
                    • If the main Encounter Favorite contains default values, it is a parent record.
                              • It displays on the Favorites list in the Exam, and when selected, it 
                                 will assign the default values to the field(s) specified.
                              • If there is a value in the ‘Child Encounter Group Name’ field, it will 
                                 also drop down to display that Subgroup.
                    • If the main Encounter Favorite does not contain default values, it is not a 
                       parent record. 
                              • It is however, the first step/level in creating the drop-down 
                                 Encounter Favorite.
                              • It displays on the Favorites list in the Exam, and when selected, it 
                                 will drop down to display the Subgroup that is attached in the ‘Child 
                                 Encounter Group Name’ field.
• Examples
          • Headaches
                    • In this example, ‘Headaches’ is the first step/level in the Favorite.
                    • There is data entered in the ‘Default Values’ field, so this is considered the 
                       ‘Parent’ record.
                    • The ‘Child Encounter Group Name’ connected is ‘Headache Location’.
                    • Subgroups
                              • The Subgroup ‘Headache Location’ has the following Detail records:
                                        • Right Temple, Left Temple, Both Temples, Across Forehead, 
                                           Back of Head and Top of Head.
                    • Patient Exam
                              • On the Chief Complaint PopUp, select ‘Encounter Favorites’ from the 
                                 ellipsis hover menu.
                              • Click the ‘Headaches’ box, and the detail items from the ‘Headache 
                                 Location’ Subgroup display.
                              • The Encounter Favorite is ‘Headaches, and it is also the ‘Parent’ and 
                                 the detail items are the ‘Children’.
                              • Select one of the detail items and click ‘OK’.
                                        • The fields will populate with the default items from 
                                           ‘Headaches’ 
                                        • And also from the detail item you selected (Example: 
                                           Complaint=Headaches and Location=right temple).
          • Headaches
                    • In this example, ‘Headaches is the first step/level in the Favorite.
                    • There is no default data, so this is not considered the ‘Parent’ record.
                    • The ‘Child Encounter Group Name’ connected is ‘Headache Location’.
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Exam > Look-up Tables
                    • Click Subgroups.
                              • The Subgroup ‘Headache Location’ has the following Detail records:
                                        • Temple and Head.
                              • These detail records represent Encounter Favorite Headers.
                              • Close out of the Subgroups table.
                    • Find and double click on ‘Temple’.
                              • This is one of the Headers that is connected to the ‘Headache 
                                 Location’ Subgroup/Child Encounter Group.
                              • There is data entered into the ‘Default Values’, so this is considered 
                                 the ‘Parent Record’ of the Encounter Favorite.
                    • The ‘Child Encounter Group Name’ connected is ‘Temple Locations’.
                    • Subgroups
                              • The Subgroup ‘Temple Locations’ has the following Detail records:
                                        • Right, Left and Both
                    • Patient Exam
                              • On the Chief Complaint PopUp, select ‘Encounter Favorites’ from the 
                                 ellipsis hover menu.
                              • Click the ‘Headaches’ box, and the Headers connected to the 
                                 ‘Headache Location’ Subgroup display.
                              • Click the ‘Temple’ box, and the detail records connected to the 
                                 ‘Temple Locations’ Subgroup display.
                              • The Encounter Favorite is ‘Headaches’, the ‘Parent’ is ‘Headache 
                                 Location’, and the ‘Temple Locations’ detail items are the ‘Children’.
                              • Select one of the detail items and click ‘OK’.
                                        • The field will populate with the default items from ‘Headache 
                                           Location’, and from the detail item you selected (Example: 
                                           Complaint=Headaches and Location=temple right).
                              • This multi-level expansion/collapse is the new ‘Collapsible 
                                 SubGroups’ functionality.

 X (1/18/2022) Look-up Tables > Encounter Favorites > Fields ADDED/EDITED

• The field 'Name' was changed to 'Display Name'.
          • This is the Name that will display when selecting a Favorite in the patient Exam.
• A NEW field 'Internal Name' was added.
          • This is the Name that will display when creating NEW Subgroups.

 X (2/10/2022) Look-up Tables > Medication > Name > ADDED: Strength Form

• The new field 'Strength Form' was added to document the Strength Form of the 
   Medication.
• This will be used when submitting compound Medications via AdvantageERx.
• Use the drop-down to access the standard list to select from.
          • This list displays from the Standard Code table, and is not editable by the user.

Function

Function > Insurance Activities
 X (3/23/2022) Insurance Activities > Claim Report Viewer > NEICSSL Program 

Retired

• Program Retired
          • Upon update to version 12.5, the NEICSSL program will be retired, and no longer 
             function for Electronic Billing Claim functions.
          • The shortcut to the program on your desktop will no longer function.
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Function > Insurance Activities
          • The creation of the billing files through 'Function > Insurance Activities > Billing' 
             has not changed.
          • There are no changes to the number of reports, timing or how they are pulled.
          • For those clients that chose to turn off the functionality of automatically uploading 
             claims, they will need to contact the Compulink EDI Support Team Immediately 
             after updating to Version 12.5 to have it turned back on (805-716-8677).
                    • This option became available in Version 12.3.
                    • It was a change only a few Users chose to make.

• Function Added
          • The new function 'Claim Report Viewer' was added into the Advantage software to 
             replace the retired desktop program.
          • From the main menu, click 'Function > Insurance Activities > Claim Report Viewer.
          • This opens the 'CHS EDI Utilities' window; it is very similar to the retired viewer.
                    • Items marked as ‘No change’ below, still function the same as they did in 
                       the retired viewer
          • Tools:
                    • Delete Claim File – No change
                              • This option should be used with caution! 
                    • Resend Change Health Claim File (Request)
                              • Used to resend the Claim file, or to manually download reports.
                              • If used for downloading reports, and there is no Claim file, then the 
                                 following message will display: No claims file found. Nothing will be 
                                 uploaded.
                              • This will be followed by a window saying, ‘Downloading Reports – 
                                 Please Wait’.
          • Viewer Filters:
                    • EMC Destination – No change
                    • From/To – No change
                    • File Type check boxes – Some labels updated, but no change to functionality
                              • EMC Claims File (837) – Previously 'EMC Claim Files (837)'
                              • EMC Report (EMC) – Previously 'EMC Reports'
                              • Remittance (835) – Previously '835 Remittance (ERA)'
                              • Remittance Report (RMT) – Previously 'Remittance Reports'
                              • File Acknowledgement (999) – Previously 'File Acknowledgments 
                                 (999)'
                              • Claims Acknowledgement (277) – Previously 'Claims 
                                 Acknowledgements (277)'
                              • Other Reports (TXT) – No change
                    • View/Requeue button – No change
                    • Raw file check box – No change
                    • Export button – No change
                    • Batch/Filename field – No change
                    • Search button – No change

Ledger

Ledger > Charge Window
 X (4/20/2022) Charge Window > Co-Pay For Office Visits Only

• The patient Co-Pay will only be posted against Office Visits starting with '992'. 
• This is also the only time that the 'Last Service' date in the 'Account Responsible' section 
   of the Demographics will be updated.
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Ledger > Charge Window
 X (12/15/2021) Charge Window > Drop-Down > Table Updated

• Drop-down display
          • When posting charges with the following commands, the drop-down will now 
             access the new Fee Options tables:
          • Material or Misc
          • Radiology (Advantage product specific table)
          • Service

• Searching for a Fee
          • In the 'Desc.' field, you may enter up to 5 characters prior to opening the table.
          • The drop-down will only display charges that contain the characters entered.

• Select Fee window
          • The 'Select Fee' window was expanded to display the following:
                    • Code – Billing CPT Code
                    • Name – Charge Name
                    • Amount – Charge Amount from the specified Fee Schedule

 X (4/7/2022) Charge Window > POS Field > Telehealth Place of Service

• 'Effective January 1, 2022, POS code 02 will be revised, and a new POS code 10 will be 
   created. When providing telehealth services to patients in their own homes, providers 
   will start using POS code 10 and stop using POS code 02.
   POS code 10 does not apply to patients who are in a hospital or other facility where the 
   patient receives care in a private residence, such as a nursing home or assisted living 
   facility. In those situations, psychologists will continue to use POS 02.'

• POS 02: Telehealth Provided in Patient's Home
          • Descriptor: The location where health services and health related services are
             provided or received through telecommunication technology. Patient is not located
             in their home when receiving health services or health related services through 
             telecommunication technology.

• POS 10: Telehealth Provided Other in Patient's Home
          • Descriptor: The location where health services and health related services are
             provided or received through telecommunication technology. Patient is located in
             their home (which is a location other than a hospital or other facility where the 
             patient receives care in a private residence) when receiving health services or 
             health related services through telecommunication technology.

Ledger > Commands

Ledger > Commands
 X (12/21/2021) Commands > Posting Update

• When posting charges with the following commands, the drop-down will now access the 
   new Fee Options tables:
          • Miscellaneous
          • Radiology (Advantage product specific table)
          • Service

• The 'Mult' command will now access the new Fee tables.
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Ledger > Command (Service)
 (4/1/2022) Service > 99024 Zero Charge Message

• When posting a 99024 charge (Post Operative Care) and saving the entry, the following 
   message will no longer display: No Global Periods are Active! Select OK to Confirm 
   posting of Zero Charge Visit!

 (4/14/2022) Service > Global Periods

• The following Global Periods were added to the table: (Request) 
          • Code: 66989, Global Period: 90 days
          • Code: 66991, Global Period: 90 days

 X (4/14/2022) Service > Place of Service

• When posting charges, the software will now pull the Place of Service from the Fee table, 
   and not the Exam screen. (Request)

Ledger > Command (Utility)
 X (12/10/2021) Utility > Fee Table Access

• The following items will now access the new Fee Options table:
          • Miscellaneous Fees 
          • Radiology Fees (Advantage product specific table)
          • Service Fees

Look-up Tables

Look-up Tables > EHR
 (5/31/2022) EHR > Medication > Name > Detail Option for Compound 

Medications

• A NEW 'Detail' command was added to allow the user to create a Compound Medication, 
   and attach the individual Components used to create the Compound.
• This Detail information will be used when Screening Medications in the patient Exam.

• Adding a Medication to the table
          • Use the 'Add' command to add the Compound Medication.
                    • Enter the Compound Medication name in the 'Name' field.
                    • Select 'Rx Type' of 'Compound Drug'.
                    • Complete all other pertinent fields and save the record.
          • To choose a 'Detail' mode, first highlight the new Compound Medication.
          • Select 'Detail > Add' (Note, this can only be done on User-Owned records)
                    • In the 'Medication Compound Component Editing' window, complete the 
                       fields:
                              • Name – Medication Name of the individual Component 
                                        • Use the drop-down to open the 'U.S. Master Drug Search' 
                                           window.
                                        • Search for the first individual Component.
                                        • Double click the Medication, and you will be taken back to the
                                           editing window; all fields will populate from the selected 
                                           Medication.
                                        • Save the Component, and it will display at the bottom of the 
                                           screen in the 'Detail Records' area.
          • With the same Compound Medication highlighted, select 'Detail > Add' to attach 
             the additional individual Components.
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• Adding a Medication to the patient
          • Go to the patient Exam Medication grid and select the 'Add' command.
          • In the 'Name' field, type all or part of the Compound name, and click the drop-
             down.
          • Select the Compound Medication from the 'Select Medication' window.
          • Complete all other pertinent fields and save the record.
          • The individual Components will be pulled into the internal table EXAMMEDDETAIL 
             upon saving the Medication record; this is not visible in the patient record.

• Screening the Medication
          • Click the E-Rx command to open the E-Prescribe window.
          • The Compound Medication Name will display in the window for Screening, but the 
             function will pull the individual Components from the EXAMMEDDETAIL table to 
             screen them individually.

• Transmitting the Medication
          • The following error will display when attempting to transmit the Medication if the 
             Detail records have not been added: Compound ingredients cannot be located.

 (4/15/2022) EHR > Medication > Name > EDITED: DEA Schedule #

• When adding a new Medication, the DEA Schedule # will default to 0 and not 1. (Request)

 (4/15/2022) EHR > Test > Name > EDITED: External Lab

• The user now has access to edit the External Lab field on Compulink-owned records. 
   (Request)

Look-up Tables > Financial
 X (12/7/2021) Financial > Fee Tables > ADDED: Sub-Menu

• Under Financial, the new sub-menu 'Fees' was added.

 X (12/17/2021) Financial > Fee Tables > Moved To New Sub-Menu

• The following tables were moved under the new 'Fees' sub-menu for better usability:
          • Category Codes (Previously 'Fee Category Codes')
          • Posting Groups (Previously 'Fee Posting Groups')
          • Group Rules (Previously 'Fee Group Rules')
          • Services
          • Radiology (Advantage product specific table)
          • Miscellaneous

 X (12/17/2021) Financial > Fee Tables > NEW Fee Table Design: 1. Introduction

• The following Fee tables have been updated with a new design for more flexibility.
          • Miscellaneous
          • Radiology (Advantage product specific table)
          • Services
• The 'Plans' table was also updated to accommodate for the new design changes.

• Options Screen
          • Upon selecting an updated table, it will now open the 'X Options' screen, where 'X' 
             is the name of the Fee table that was selected. Example: Service Options.
          • This screen is similar to the 'Fee Schedule Descriptions' in the legacy tables.
          • A new 'Display Order' allows control of the order of entries in the table.
          • The 'Place of Service' and 'Type of Service' will now display the full description, and
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Look-up Tables > Financial
             not just the code.
          • The new 'Schedule' command opens the 'X Fee Schedule: Standard' screen, where 
             'X' is the name of the Fee table that was selected. Example: Service Fee Schedule:
             Standard.

• Standard Schedule
          • If updating from a previous version, the software will convert the first Fee 
             Schedule in the legacy table (usually Self Pay) to the 'Standard' schedule.
          • The table MUST contain a Fee Schedule with 'Standard' as the Name, as there is 
             specific programming looking for that Name.
          • Identifying your Standard Fee Schedule:
                    • If you use the ‘Commercial’ column for payors without a contracted fee 
                       schedule; and this is your starting point for building fee schedules for 
                       contracted payors, this is your ‘Standard’ Fee Schedule.
                    • If your practice is out of network, and patients are expected to pay the 
                       office in full and file their own insurance, then the ‘Self Pay’ column is your 
                       ‘Standard’ Fee Schedule. 

• Other Fee Schedules
          • All other Fee Schedules will be converted with the column number that was 
             assigned in the legacy table.
          • The 'Goto' command will still be used to move to other Fee Schedules.
                    • The legacy 'Back' and 'Next' commands are no longer needed.

• Creating a Fee Schedule
          • Duplicate command
                    • Use this to create a new Fee Schedule that contains all of the same 
                       information as an existing Fee Schedule.
                    • Use 'Goto' to find the original Fee Schedule, then click 'Duplicate' to make a 
                       copy and assign a name to the new one.
          • Schedule command
                    • This opens the 'X Fee Schedules' table, where 'X' is the name of the Fee 
                       table that was selected. Example: Service Fee Schedules.
                    • Here you can add a new Fee Schedule Name, and once saved, the new Fee 
                       Schedule will be available.
                    • A new option for 'Inherit Fee Schedule' displays a list of the existing Fee 
                       Schedules/Price Groups to copy from.
                              • If left blank, the new Fee Schedule will be created, and the following 
                                 fields will be left blank:
                                        • Amount
                                        • Ins. Paid
                                        • Allowed
                                        • Cost
                                        • CPT Code
                                        • Modifier #1
                                        • Modifier #2
                              • If an existing Fee Schedule/Price Group is selected, the new Fee 
                                 Schedule will be created, and all Fee information will be displayed 
                                 from the selected one.
                                        • If the user edits the Amount, Ins. Paid or Allowed fields on the
                                           NEW Fee Schedule, they will save with the new changes.
                                        • If these fields are not edited, they will 'Inherit' and display the
                                           values that are in the Fee Schedule that is listed in the 
                                           'Inherit Fee Schedule' field.
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                                        • This is a HUGE help when updating amounts in the future.
                                                  • Standard Fee Schedule is set as the one to Inherit 
                                                     from on 5 other Fee Schedules.
                                                  • Change the Amount on the Standard Fee Schedule, 
                                                     and that updated value will display on all 5 other Fee 
                                                     Schedules.
                                                  • No longer a need to go to the other 5 and update the 
                                                     Amount as well.
                              • See the following topics for complete details:
                                        • Look-up Tables > Financial > Fee Tables > NEW Fee Table 
                                           Design: Pricing Schedule Screen
                                        • Look-up Tables > Financial > Fee Tables > NEW Fee Table 
                                           Design: Fee Schedules Table

• Starting and Ending a Fee Schedule
          • The new 'X Fee Schedules' table allows the user to enter a Start/End date to 
             control when a Fee Schedule is available to use.
          • Using the 'Start' and 'End' dates:
                    • The 'Start' date:
                              • Controls when the Fee Schedule will become available to use.
                    • The 'End' date:
                              • Controls when the Fee Schedule is no longer available to use.

• Hiding Individual Entries on Specific Fee Schedules
          • The 'Options' screen displays all charges that you post in your practice.
          • If some of those charges are not available for a particular Price Group, they can be
             hidden on that Fee Schedule.
          • Any entries that are marked with 'Hide'=Y will not display when posting charges 
             for a patient with a Payor connected to the specified Fee Schedule.
          • Hiding an entry:
                    • Use the 'Goto' command to find the Fee Schedule.
                    • Find the charge entry that you want to Hide, edit and set 'Hide'=Y.
                    • The 'Hide' command is also available at the top, and can be used if multiple 
                       items need to be hidden.

• How Does Everything Connect?
          • Fee Schedules table (new table)
                    • This is where Names are assigned to Fee Schedules.
                    • The first Fee Schedule in the legacy table will be converted to “Standard”.
                    • The rest of the Fee Schedules will be converted with the number that was 
                       assigned to them in the legacy table. Example: Column 2, Column 3 etc.
                    • If the legacy table had 10 Fee Schedules, there will be 10 entries.
          • Fee Schedules (new table)
                    • This is where fees are assigned to the charges.
                    • The header at the top will display the Name of the Fee Schedule from the 
                       Fee Schedules table (see above).
          • Plans table (existing table)
                    • This is where the Plan is mapped to the Fee Schedule.
                    • The headers now read 'Service Fee Schedule' and 'Material Fee Schedule'.
                    • If the legacy table contained a '1' under either of the headers, it will now 
                       say 'Standard'.
                    • If the legacy table contained a number greater than '1', that number will 
                       display with the word “Column” in front of it. Example: Column 2.
                    • Since multiple Plans could be pointed to the same number, there may be 
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                       several Plans that display 'Column 2'.

• Do I Need to Rename Anything?
          • If in the legacy table your 'Standard' Fee Schedule was number 2, then you will 
             need to rename 'Standard' to match what your legacy table had set as number 1.
          • Next rename 'Column 2' to 'Standard'.
          • The Plans table will now display that change.
          • It is NOT mandatory for you to rename anything else for this functionality to work.
          • You may use this as an opportunity to create new names for your existing Fee 
             Schedules. Example:
                    • 'Column 3' could be renamed to 'Commercial'.
                    • Once that change is made, in the Plans table, any Plan that had 'Column 3' 
                       connected to it will now display 'Commercial'.

• The following areas have been updated to use the new Fee Table Design:
          • Exam > Fees command
          • Ledger > Miscellaneous command
          • Ledger > Mult command
          • Ledger > Radiology command (Advantage product specific table)
          • Ledger > Service command

 X (4/28/2022) Financial > Fee Tables > NEW Fee Table Design: 2. Options Screen

• Upon selecting an updated table, it will now open the 'X Options' screen, where 'X' is the 
   name of the Fee table that was selected. Example: Service Options.
• This screen is similar to the 'X Fee Schedule Descriptions' in the legacy tables.
          • It includes general information about an entry; it is not Plan/Fee Schedule specific.
          • This is where you Add new entries, Edit or Delete existing entries and assign 
             general information.

• Table Commands
          • Search
                    • Use the Search icon to quickly perform an alphabetical search of your 
                       choice of fields in the table.
                    • Select Field to Search and click OK.
                    • Accept the default 'Post Code' or open the drop-down list to search the 
                       contents of the 'Name' field.
                    • Enter your search characters and click OK.
                    • We recommend that you perform a search prior to adding new records to a 
                       look-up table to confirm the entry doesn't already exist. 
          • Add
                    • Add a new Description/Name to the bottom of the table.
                    • You may only Add on the Options screen.
                    • Use the 'Display Order' on the Editing window if you would prefer to place 
                       the new table entry at a specific spot, rather than at the bottom.
          • Edit
                    • Modify the highlighted entry.
          • Delete
                    • Permanently remove the highlighted charge. 
                    • The following prompt will display: Are you SURE you want to Delete 
                       highlighted item AND ALL Detail entries associated with it?
                    • Click 'Yes' to delete the highlighted entry (there is no UNDO).
                    • You may only Delete on the Options screen. 
          • Print
                    • Generates a Crystal Report to the screen that can be saved, exported or 
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                       printed.
                    • The report is generated for the table that it was selected to print from, and 
                       that name will display across the top; Example: Fee Schedule for Services.
                    • The data includes information from the Options and the Fee Schedules; All 
                       Schedules, All Plans.
                    • Fee Schedule(s) by Name and Associated Financial Plans
                              • The table at the top will display the Fee Schedule name, followed by 
                                 the Financial Plans that are attached to that Fee Schedule.
                              • Example: Fee Schedule: Medicare
                                        • Medicare
                                        • Medicare DME
                                        • RR Medicare
                    • Charges are listed by Post Code, followed by the Detail Information.
                    • Header:
                              • These items are found on the 'Options' screen, and are global for all 
                                 Fee Schedules:
                                        • PostCode – Charge Post Code
                                        • Description – Charge Description
                                        • Cat. Code-Category – Charge Category Code or description
                                        • POS Code-POS – Charge Place of Service Code or description
                                        • Units – Default Charge Units
                                        • TOS Code-TOS – Charge Type of Service Code or description
                    • Detail Information:
                              • These items are found on the individual 'Fee Schedule' screens, so 
                                 data may vary per line:
                                        • Fee Schedule Name
                                        • Ins. Code – Charge Billing Code 
                                        • Modifiers – Modifiers used for billing Charge
                                        • Tax – Taxable Y/N
                                        • Cost – Cost to the practice for Charge
                                        • Charge – Usual & Customary Fee for Charge
                                        • Ins Paid – Defined Insurance Paid Amount for Charge
                                        • Allowed – Defined Allowed Billing Amount for Charge
          • Schedules
                    • Opens the 'Pricing for X Fee Schedule: Standard' screen, where 'X' is the 
                       name of the Fee table that was selected. Example: Pricing for Service Fee 
                       Schedule: Standard)
                    • Standard Schedule
                              • If updating from a previous version, the software will convert the 
                                 first Fee Schedule in the legacy table (usually Self Pay).

• Add a New Entry to the Table
          • Use the 'Add' command to open the 'Fees Editing' window, and complete the fields.
          • Display Order
                    • You can assign a number between 1-999998 to control where this item 
                       appears in the drop-down list when posting charges on the Ledger.
                    • Upon update to version 12.5, all entries will be assigned a 'Display Order' 
                       in increments of 20. Example: 20, 40, 60 etc.
                    • This allows the user to add new entries with 'Display Order' numbers 
                       between those items. Example: 21, 22, 23 etc.
          • Start
                    • Availability Start date for this entry.
                    • If set to a date in the future, this entry will not be able to be charged out 
                       from the Exam until that date.
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                    • The entry will not display in the drop-down at the Ledger until that date.
          • End
                    • Availability End date for this entry.
                    • If set to a date in the past, this entry will not be able to be charged out 
                       from the Exam.
                    • The entry will not display in the drop-down at the Ledger.
          • Post Code
                    • Used for automated Exam posting and as a Ledger shortcut.
                    • Post Codes are used by smart scripts throughout the EHR, and as a Ledger 
                       posting shortcut in combination with the F8 function key.
                    • Each one must be unique, and a maximum of 5 characters.
                    • Match the Insurance billing code, or use any combination of letters and 
                       numbers. Avoid special characters such as $!?.
                    • Be sure to check with Compulink before changing an established Post Code 
                       to avoid issues posting exam charges.
          • Name
                    • Description for the charge.
                    • Charge fields were increased, so you no longer have to enter '$n' at the end
                       of the description for any charges over $9999.99.
          • Units
                    • Units or days associated with charge; defaults to 1, but may be changed.
          • Place of Service 
                    • Place where charge was provided. Select from drop-down.
                    • The 'Select Item' window displays the Code and the Description.
          • Type of Service
                    • Type of Service that was performed. Select from drop-down.
                    • The 'Select Item' window displays the Code and the Description.
          • Category
                    • Sub-classification on financial reports. Select from drop-down.

• Fields no longer used in the new table structure
          • RVU
                    • This field is internally maintained by Compulink.
          • Diag List
                    • Field retired.

 X (4/28/2022) Financial > Fee Tables > NEW Fee Table Design: 3. Pricing Schedule 
Screen

• From the 'X Options' screen, click 'Schedules' to access the 'X Fee Schedule: Standard' 
   screen, where 'X' is the name of the Fee table that was selected. Example: Service Fee 
   Schedule: Standard.

• Table Commands
          • Search
                    • Use the Search icon to quickly perform an alphabetical search of your 
                       choice of fields in the table.
                    • Select Field to Search and click OK.
                    • Accept the default 'Post Code' or open the drop-down list to search the 
                       contents of the 'Name' field.
                    • Enter your search characters and click OK.
          • Edit
                    • Modify the highlighted entry.
          • Delete – In Development.
          • Print
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                    • Generates a Crystal Report to the screen that can be saved, exported or 
                       printed. (Request)
                    • The report is generated for the table that it was selected to print from, and 
                       that name will display across the top; Example: Fee Schedule for Services.
                    • The data includes information from the Fee Schedule that is displayed when
                       the Print command is selected.
                    • Fee Schedule(s) by Name and Associated Financial Plans
                              • The table at the top will display the Fee Schedule name, followed by 
                                 the Financial Plans that are attached to that Fee Schedule.
                              • Example: Fee Schedule: Medicare
                                        • Medicare
                                        • Medicare DME
                                        • RR Medicare
                    • Charges are listed by Post Code, followed by the Detail Information.
                    • Header:
                              • These items are global for all Fee Schedules:
                                        • PostCode – Charge Post Code
                                        • Description – Charge Description
                                        • Cat. Code-Category – Charge Category Code or description
                                        • POS Code-POS – Charge Place of Service Code or description
                                        • Units – Default Charge Units
                                        • TOS Code-TOS – Charge Type of Service Code or description
                    • Detail Information:
                              • These items are found on the individual 'Fee Schedule' screen.
                                        • Fee Schedule Name
                                        • Ins. Code – Charge Billing Code 
                                        • Modifiers – Modifiers used for billing Charge
                                        • Tax – Taxable Y/N
                                        • Cost – Cost to the practice for Charge
                                        • Charge – Usual & Customary Fee for Charge
                                        • Ins Paid – Defined Insurance Paid Amount for Charge
                                        • Allowed – Defined Allowed Billing Amount for Charge
                              • If you are using the 'Inherit' functionality, the report will only display 
                                 the Charge lines that have been edited, and the 'Inherited' field 
                                 unchecked.
          • Goto
                    • Used to move between the Service Fee Schedules.
                    • Goto > Fee Schedule by Name
                              • Quickly access Fee Schedules you know the Name for.
                              • Opens the 'Select Fee Schedule' window that displays both the 
                                 'Name' and 'Inherited from' values.
                              • Select a Fee Schedule to Goto/Jump to.
                    • Goto > Fee Schedule by Plan
                              • Quickly access Fee Schedules that are mapped to a specific Plan.
                              • Opens the 'Select Plan' window that displays the items from the 
                                 Financial Plans table.
                              • Select a Plan to Goto/Jump to its assigned Fee Schedule.
          • Schedule
                    • Opens the 'X Fee Schedules' screen, where 'X' is the name of the Fee Table 
                       that was selected. Example: Service Fee Schedules.
                    • See the following topic for details on this table: Look-up Tables > Financial 
                       > Fee Tables > NEW Fee Table Design: Fee Schedules Table.
          • Test
                    • Gives you the expected Ledger Posting results of a highlighted charge.
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                    • You will be prompted to enter the expected insurance payment percentage 
                       (your Medicare Fee Schedule will default to 80%).
                    • The 'Ledger Posting Expected Results' window displays the following results 
                       expect to post, based upon the setup:
                              • Amount
                              • Adjustment (Contractual)
                              • Patient Due
                              • Insurance Due
          • Export
                    • Send the contents of this table to a CSV file that may be modified in a 3rd 
                       party program such as Microsoft Excel.
                    • This feature has been enhanced from previous version to be more user 
                       friendly. (Request) 
                    • Click 'Export' and you will see 'Export data to FeeScheduleX.CSV 
                       complete!". ('X' is the name assigned to the Fee Schedule displayed).
                       Example: Export data to FeeScheduleMedicare.CSV
                    • This is the file name you will open and modify in Excel. 
                    • NOTE: This is only used for Exporting existing Fees to edit, not for adding 
                       new Fees to Import. The number of records Imported, must match the 
                       number of records Exported.
          • Import
                    • Imports a comma delimited file into the displayed table.
                    • Click 'Import' and a prompt 'Select YES to Confirm Import of 
                       FeeScheduleX.CSV' offers 'Yes', 'No' or 'Cancel'.
                    • Yes will bring the contents of the CSV file into your table.
                    • NOTE: This is only used for Importing the Fees that were Exported and 
                       edited, do NOT add new Fees to the CSV file for Importing. The number of 
                       records Imported, must match the number of records Exported.
          • Filter
                    • Used to control which table entries are displayed.
                    • Off – Select to display ALL table entries; this is the default.
                    • UnHidden – Select to display entries that are not marked 'Hide'=Y.
          • Duplicate
                    • Create a new Fee Schedule with a new Name; similar to the 'New' command
                       in the legacy table.
                    • Click 'Duplicate' and you will see 'Select YES to confirm Duplication!'
                    • The 'Duplicate Fee Schedule' window opens for you to 'Enter Name of NEW 
                       Fee Schedule' and click 'OK'. Click 'Cancel' to cancel duplication.
                    • A copy of the displayed Fee Schedule is made and assigned the NEW Fee 
                       Schedule Name that was entered.
                    • Use 'Duplicate' to establish different levels of pricing in your Charge tables.
          • Hide
                    • Places you into record <Hide> mode. 
                    • Double click on a table entry to toggle Hide from 'N' to 'Y'. 
                    • This entry will no longer appear in the table drop-down 
                    • Click 'Hide' again to stop.

• Editing an Entry in the Table
          • The display across the top of the table includes the item 'Inherited'.
                    • This is not an editable field.
                    • A check will display in the box next to the entry if the Fee Schedule is 
                       assigned an 'Inherit Fee Schedule' in the Fee Schedule table.
                    • This entry will Inherit/Display the Fees established in the designated 'Inherit
                       Fee Schedule'
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          • Use the 'Edit' command to open the 'Fee Schedule Editing' window for the 
             highlighted charge, and complete the fields.
          • Hide
                    • Used to Hide this entry and prevent posting for this Fee Schedule. 
                    • Set to 'N' to make this entry available on the drop-down for posting.
                    • Set to 'Y' to prevent it from displaying on the drop-down for posting.
          • Amount
                    • The Usual & Customary fee charged to the patient for this entry.
                    • Charge fields were increased, so you no longer have to enter '$n' at the end
                       of the description for any charges over $9999.99.
                    • Upon update to version 12.5, the software will calculate any existing entries
                       with the '$n', and place the correct Amount in the table.
          • Insurance Paid
                    • A flat fee expected from the carrier.
                    • Leave blank if Insurance is reimbursing on a percentage basis.
                    • Any difference between 'Amount' and 'Insurance Paid' is added to the 
                       Responsible balance.
          • Insurance Allowed
                    • Maximum allowable amount (Example: Medicare allowable).
          • Cost 
                    • Cost to the practice for this charge.
          • CPT Code
                    • Insurance Billing Code that identifies this item on a claim.
                    • Charges without a CPT Code will not bill to Insurance.
                    • If special circumstances require you to bill negative charge amounts on an 
                       Insurance claim, enter CPT Code ZZZZZ.
          • Modifier #1
                    • The first Modifier Code that you always want to post with the charge. 
                    • You may also assign Modifiers during the Ledger posting.
          • Modifier #2
                    • The second Modifier Code that you always want to post with the charge. 
                    • You may also assign Modifiers during the Ledger posting.
          • Taxable
                    • Enter 'Y' if entry is Taxable for this Fee Schedule, otherwise enter 'N'.

 X (4/28/2022) Financial > Fee Tables > NEW Fee Table Design: 4. Fee Schedules 
Table

• From the 'X Fee Schedule' screen, click 'Schedule' to access the 'X Fee Schedules' screen, 
   where 'X' is the name of the Fee table that was selected. Example: Service Fee 
   Schedules.

• Table Commands
          • Search
                    • Use the Search icon to quickly perform an alphabetical search of your 
                       choice of fields in the table.
                    • Select Field to Search and click OK.
                    • Accept the default 'Name' or open the drop-down list to search the 
                       contents of the 'Inherit Fee Schedule' field.
                    • Enter your search characters and click OK.
          • Add
                    • Add a new Fee Schedule Name to the bottom of the table.
                    • Use the 'Display Order' on the Editing window if you would prefer to place 
                       the new table entry at a specific spot, rather than at the bottom.
          • Edit
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                    • Modify the highlighted entry.
          • Delete
                    • Permanently remove the highlighted Fee Schedule Name. 
                    • The following prompt will display: Are you SURE you want to Delete 
                       highlighted item AND ALL Detail entries associated with it?
                    • Click 'Yes' to delete the highlighted entry.
          • Filter
                    • Used to control which table entries are displayed.
                    • Off – Select to display ALL table entries; this is the default.
                    • UnHidden – Select to display entries that are not marked 'Hide'=Y.
                    • Hidden – Select to display entries that are marked 'Hide'=Y.
          • Hide
                    • Places you into record <Hide> mode. 
                    • Double click on a table entry to toggle Hide from 'N' to 'Y'. 
                    • This entry will no longer appear in the table drop-down 
                    • Click 'Hide' again to stop.
          • Utility
                    • Used to filter the list of items in the table.
                    • Hide All – Mark ALL entries as 'Hide=Y'.
                    • UnHide All – Mark ALL entries as 'Hide='N'.

• Add a New Entry to the Table
          • Use the 'Add' command to open the 'Fees Schedules Editing' window, and complete
             the fields.
          • Display Order
                    • You can assign a number between 1-999998 to control where this item 
                       appears in the drop-down list.
                    • Upon update to version 12.5, all entries will be assigned a 'Display Order' of
                       '999999', but may be changed.
                    • If left with the default, they will display in the order in which they are 
                       entered into the table.
          • Hide 
                    • Used to Hide this entry and prevent posting with this Fee Schedule.
                    • Set to 'N' to make this entry available on the drop-down.
                    • Set to 'Y' to prevent it from displaying on the drop-down.
          • Name
                    • Description for the Fee Schedule.
          • Inherit Fee Schedule 
                    • Displays a list of existing Fee Schedules to display from.
                    • If left blank, the new Fee Schedule will be created, and the following fields 
                       will be left blank:
                              • Amount
                              • Ins. Paid
                              • Allowed
                              • Cost
                              • CPT Code
                              • Modifier #1
                              • Modifier #2
                    • If an existing Fee Schedule is selected, the new Fee Schedule will be 
                       created, and all Fee information will be displayed from the selected one.
                              • If the user edits the Amount, Ins. Paid or Allowed fields on the NEW 
                                 Fee Schedule, they will save with the new changes.
                              • If these fields are not edited, they will 'Inherit' and display the 
                                 values that are in the Fee Schedule that is listed in the Inherit Fee 
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                                 Schedule' field.
                              • This is a HUGE help when updating amounts in the future.
                                        • Standard Fee Schedule is set as the one to Inherit from on 5 
                                           other Fee Schedules.
                                        • Change the Amount on the Standard Fee Schedule, and that 
                                           updated value will display on all 5 other Fee Schedules.
                                        • No longer a need to go to the other 5 and update the Amount 
                                           as well.
          • Start
                    • vailability Start date for this entry.
                    • Defaults to blank; if left blank, the entry is immediately available.
                    • If set to a date in the future, this entry will not be available until that date.
          • End
                    • Availability End date for this entry.
                    • Defaults to blank; if left blank, the entry is immediately available.
                    • If set to a date in the past, this entry is no longer available.

 X (1/7/2022) Financial > Fees > Category Codes > Fields Added/Edited

• The following new fields were added:
          • Display Order
                    • You can assign a number between 1-999998 to control where this item 
                       appears in the drop-down list.
                    • Upon update to version 12.5, all entries will be assigned a 'Display Order' 
                       of '999999', so they will display in the order in which they are entered.
                    • Edit the records to change the 'Display Order' if needed.
          • Hide
                    • Used to Hide this entry in the drop-down.
                    • Set to 'N' to make this entry available in the drop-down.
                    • Set to 'Y' to prevent it from displaying in the drop-down.

• The 'Code' field was renamed to 'Legacy Code'.
          • When editing the new Fee Table 'Options', the 'Category' drop-down now displays 
             the full 'Name' field.

 (2/10/2022) Financial > Payors > Names > EDITED: Fax

• The user now has access to edit the 'Fax' field on Compulink-Owned records. (Request)

 X (3/15/2022) Financial > Plans > Table Updated

• The table was updated for the new Fee Table design.
• This is where the Plan is mapped to the Fee Schedule.
• The headers now read 'Service Fee Schedule', 'Miscellaneous Fee Schedule' and 
   'Radiology Fee Schedule' (product specific).
          • If the legacy table contained a '1' under either of the headers, it will now say 
             'Standard'.
          • If the legacy table contained a number greater than '1', that number will display 
             with the word “Column” in front of it. Example: Column 2.
          • Since multiple Plans could be pointed to the same number, there may be several 
             Plans that display 'Column 2'.

• Adding/Editing a record
          • When adding a new record, or editing an existing one, the 'Plan mapping to Fee 
             Schedules Editing' window now displays the new header description, and contains 
             a drop-down to access the Fee Schedules table to select from.
                    • If the Service Fee Schedule is left empty, the software will automatically use
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                       the ‘Standard’ Fee Schedule.
                    • If there is no Fee Schedule named ‘Standard’, and this field is left empty, 
                       the user will receive the following message when accessing the Ledger, and 
                       when attempting to post charges: Unable to Locate “Standard” Fee 
                       Schedule for Services!

• Location Specific Pricing Override and Filtering
          • Location specific sub-folders are no longer needed in the Advantage product folder.
          • When adding 'Detail' to the highlighted Plan, a new 'Location Group Plan/Fee 
             Schedule Mapping Editing' window opens.
          • Hide – Used to Hide this entry and prevent this mapping from being used.
                    • Set to 'N' to make this mapping available for posting for the specified 
                       Location Group and Fee Schedules for this Plan.
                    • Set to 'Y' to prevent it from being used for posting.
          • Location Group – The Location Group assigned to the specified Fee Schedules for 
             this Plan.
          • Service Fee Schedule – The Service Fee Schedule assigned to the specified Plan 
             and Location Group.
          • Misc/Material Fee Schedule – The Misc/Material Fee Schedule assigned to the 
             specified Plan and Location Group.
          • Radiology Fee Schedule – The Radiology Fee Schedule assigned to the specified 
             Plan and Location Group. (Advantage product specific)

Look-up Tables > General
 (4/15/2022) General > Labs > List > EDITED: Fax

• The user now has access to edit the Fax field on Compulink-owned records. (Request)

 (1/27/2022) General > Location > Details > NEW Fields Added

• Hide
          • This new field allows the user to set up a new Location, and not display it as an 
             option until ready.
          • It can also be used to discontinue, or remove an existing Location from displaying.
                    • This may be if the Location/Office was closed.
          • Setting the 'Hide' field:
                    • Set to 'N' to make this entry available in the Demographic drop-down.
                    • Set to 'Y' to prevent it from displaying in the Demographic drop-down.

• User #1, User #2 and User #3
          • These new fields allow the user to enter any data about the Location that they 
             choose.
          • At this time, the data is only stored in the table, and not used throughout the 
             software.

 X (4/14/2022) General > Provider > NEW Field Added

• Automatic Formulary
          • This new field allows the user to control if AdvantageERx automatically runs the 
             Formulary check when accessing the E-Prescribe window.
          • The field defaults to Y to continue with the current functionality of having it run.
          • If set to N, the software will bypass doing the Formulary search, and speed up the 
             process of prescribing a medication.
          • This is a per provider setting.
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 X (2/24/2022) Inventory > Vendors > New Table

• This table replaces the existing table, and can support Vendor IDs per Location.
• If the legacy table contains additional columns, upon update, that information will be 
   converted to Detail records attached to the Vendor.

• The Vendors table stores vendor information used for Inventory Orders and for posting 
   invoices to Accounts Payable.
          • It supports the Vendor field found on each Inventory Description screen.
          • It may also be used to record the A/P account number of Vendors for automatic 
             posting of invoices to Accounts Payable during Inventory Receive.

• Table Commands
          • Search
                    • Use the Search icon to quickly perform an alphabetical search of your 
                       choice of fields in the table.
                    • Select Field to Search and click OK.
                    • Accept the default of 'Name', or open the drop-down list to search the 
                       contents of 'Phone', 'Fax' or 'Account ID'.
                    • Enter your search characters and click OK.
                    • We recommend that you perform a search prior to adding new records to a 
                       look-up table to confirm the entry doesn't already exist. 
          • Add
                    • Add a new Vendor to the bottom of the table.
                    • Use the 'Display Order' on the Editing window if you would prefer to place 
                       the new table entry at a specific spot, rather than at the bottom.
          • Edit
                    • Modify the highlighted Vendor.
          • Delete
                    • Permanently remove the highlighted Vendor. 
                    • The following prompt will display: Are you SURE you want to Delete 
                       highlighted item AND ALL Detail entries associated with it?
                    • Click 'Yes' to delete the highlighted entry (there is no UNDO).
          • Filter
                    • Used to control which table entries are displayed.
                    • Off – Select to display ALL table entries; this is the default.
                    • UnHidden – Select to display entries that are not marked 'Hide'=Y.
                    • Hidden – Select to display entries that are marked 'Hide'=Y.
          • Detail
                    • Add a Detail record to the highlighted table entry.
                    • Add – Used to add the Detail record
                    • Delete – Used to remove the highlighted Detail record
                    • Edit – Used to edit the highlighted Detail record
          • Hide
                    • Places you into record <Hide> mode. 
                    • Double click on a table entry to toggle Hide from 'N' to 'Y'. 
                    • This entry will no longer appear in the table drop-down. 
                    • Click Hide again to stop.
          • Utility
                    • Used to filter the list of items in the table.
                    • Hide All – Mark ALL entries as 'Hide=Y'.
                    • UnHide All – Mark ALL entries as 'Hide='N'.

• Add a New Entry to the Table
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          • Use the 'Add' command to open the 'Vendor Editing' window, and complete the 
             fields.
          • Hide
                    • Used to Hide this entry in the drop-down.
                    • Set to 'N' to make this entry available in the drop-down.
                    • Set to 'Y' to prevent it from displaying in the drop-down.
          • Display Order
                    • You can assign a number between 1-999998 to control where this item 
                       appears in the drop-down list.
                    • Upon update to version 12.5, all entries will be assigned a 'Display Order' 
                       in increments of 20. Example: 20, 40, 60 etc.
                    • This allows the user to add new entries with 'Display Order' numbers 
                       between those items. Example: 21, 22, 23 etc.
          • Name
                    • Vendor Name
          • Phone
                    • Vendor's Phone number
          • Fax
                    • Vendor's Fax number
          • Account #
                    • The practice customer number with the Vendor.
                    • If your practice has multiple Locations, and each one has their own 
                       Account #, enter the # for the primary/main Location here, and add the 
                       others using the 'Detail > Add' command.

• Adding a Detail record
          • To choose a 'Detail' mode, first highlight the Vendor.
          • Select 'Detail > Add'.
                    • In the 'Vendor Detail Editing' window, complete the fields:
                              • Location
                                        • Practice Location that purchases from this Vendor.
                                        • Use the drop-down to open the 'Select Location' window 
                                           displaying the Location Details table.
                                        • Double click the Location you wish to connect to the Vendor.
                              • Location Acct #
                                        • The customer number the Vendor assigned this Location.
                              • AP Acct #
                                        • The Accounts Payable number assigned to this 
                                        • Location/Vendor combination in the Advantage software.
          • With the same Vendor highlighted, select 'Detail > Add' to attach additional
             Location information.

Patient

Patient > Display Changes
 (4/13/2022) Display Change(s) > Header > Co-Manage Caption

• If the Referral Source is marked Co-Manage=Y, the Co-Manage caption will display at the 
   top of the Demographic screen, followed by the name in the Business field of the Referral 
   Source. (Request)

Patient > Commands
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Patient > Command (Add)
 (2/17/2022) Add > Companion > Additional Fields Added

• When adding a Companion record, the following additional fields will forward from the 
   original account:
          • Patient database
                    • Local – Preferred Local Pharmacy
                    • Mail Order – Preferred Mail Order Pharmacy
          • Bill/Account Responsible database
                    • DOB – Date of birth
                    • Sex – Gender 
                    • Cell – Cell phone
          • Episode database
                    • All Episodes with an empty 'Episode End' date.

Patient > Command (Print)
 (5/3/2022) Print > Letter >   Cancel Fax

• When sending a fax from the Patient or Exam, and using PracticeWatch Delivery, you will 
   have the option to cancel the fax prior to it being sent. (Request) 
• Go to the History tab on the Demographics and find the entry with Type of Fax and Status
   of Local Queue.
• Highlight the line, right click and select Cancel.
          • You may also highlight the ellipsis hover menu and select Cancel.
• Click OK on the following message that displays: Document has been Successfully 
   Canceled!
• The Status will change from Local Queue to Canceled.

 (4/1/2022) Print > Report >   EDITED: PatientApptFuture

• The patient name at the top of the report is now in bold font. (Request)
• The report will now include Appointments scheduled for the current date (on or after the 
   time that the report is merged). Request

Patient > Command (Utility)
 (3/4/2022) Utility > Patient Portal > Login History > New Utility

• The new Utility ‘Patient Portal > Login History’ was added to display the patient’s Login 
   activity for the past 90 days.
• When clicked, the ‘Portal 90 day Login History for: X’ (X=patient last name, first name 
   middle initial) window will open, displaying the following:
          • Added date
          • Reason
• If the patient has no Login activity, the following message will display: Unable to Locate 
   any items matching search criteria!

Patient > Layouts & Tabs
 (3/31/2022) Tab(s) >   EDITED: Patient

• The actual name of the tab will vary by product, but the Tab Label = Patient.
• Appointment History panel
          • Ellipsis hover menu
                    • The report view for the option ‘Print Future Appointments’ was updated.
                              • The patient name at the top of the report is now in bold font. 
                                 (Request) 
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                              • The report will now include Appointments scheduled for the current 
                                 date (on or after the time that the report is merged). Request

Reports

Reports > Appointment
 (2/25/2022) Appointment > Analysis > ADDED: Group Attendance Statistics

• Report shows patient attendance in Groups for which they are enrolled. (Request)
• It includes the following summaries:
          • Attendance Status by scheduled Location and responsible staff ID.
          • Attendance Status by scheduled Location and Group Name.
• Parameters/Options:
          • Location (Session) – Location Code associated with the Group Schedule
          • ID (Staff) – ID in the Group Schedule for the staff person responsible for Session
          • Start Date (Session) – Include Sessions that occurred starting from this date.
                    • Default is the current date.
                    • Single left click the date to use the drop-down arrow to display a Calendar.
          • End Date (Session) – Include Sessions that occurred prior to this date.
                    • Default is the current date.
                    • Single left click the date to use the drop-down arrow to display a Calendar.
          • ID (2nd Staff) – ID in the Group Schedule for the 2nd staff person responsible
          • Group Name – Name of the Group on the Schedule
          • Category (on Group Schedule) – Category of the Group on the Schedule
          • Purpose (Group Session) – Purpose of the Group on the Schedule
          • Required Only? - Option to run for patients with Required Session(s)
                    • Default is 'False' to show all patients.
                    • If set to 'True', the report will only include patients with required Session(s).
          • Show Patient Detail? - Option to run for Summary or Patient Details
                    • Default is 'True' to show Patient Details per Group, followed by Summaries.
                    • If set to 'False', the report will only show Summaries.
• Report (Patient Detail):
          • The data is organized by 'Location (Session)', then 'ID (Responsible)', then Session
             Date and Time.
          • Detailed information includes the following:
                    • ID – ID in the Group Schedule for the staff person responsible for Session
                    • Session – Date the Session was held
                    • Time – Start time of the Session
                    • Reason/Group Name – Name of the Group on the Schedule
                    • Patient Name – First and Last name of the patient assigned to the Session
                    • Required? – Yes/No to indicate if this is a Required Session for the patient 
                    • Attendance Status – Status of the Session for the patient
                              • Example: Pending/Scheduled, Canceled, No-Show or Attended
• Summary: Group Listing – Reason (Group Name) by Location
          • Total – Total number of patients assigned to ALL Groups, across ALL Locations in 
             the reporting period
          • Subtotals for the number of patients assigned to the following:
                    • Individual Location and ALL Group Names
                    • Individual Group Name
• Summary: Group Listing – Reason (Group Name) by Location and Responsible Staff ID
          • Total – Total number of patients assigned to ALL Groups, for ALL Staff IDs, across 
             ALL Locations in the reporting period
          • Subtotals for the number of patients assigned to the following:
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                    • Individual Location, ALL Staff IDs and ALL Group Names
                    • Individual Staff ID and ALL Group Names
                    • Individual Staff ID and individual Group Name
• Summary: Attendance Status by Responsible Staff ID
          • Total – Total number of patients assigned to ALL Groups, for ALL Staff IDs, across 
             ALL Locations in the reporting period
          • Subtotals for the number of patients assigned to the following:
                    • Individual Location, ALL Staff IDs and ALL Statuses 
                    • Individual Staff ID and ALL Statuses
                    • Individual Staff ID and individual Status
          • Percentages for the Statuses assigned to the patients at an individual Location for 
             the following:
                    • Individual Location, individual Staff ID and ALL Statuses 
                    • Individual Location, individual Staff ID and individual Status
          • Percentages for the Statuses assigned to the patients at ALL Locations for the 
             following:
                    • ALL Locations, individual Staff ID and ALL Statuses 
                    • ALL Locations, individual Staff ID and individual Status
• Summary: Attendance Status by Location and Reason (Group Name), percentage of 
   Location Total
          • Grand Total – Total number of patients assigned to ALL Statuses, ALL Groups, 
             across ALL Locations in the reporting period
          • Percentages for the Statuses assigned to the patients at an individual Location for 
             the following:
                    • Individual Location, individual Group Name and ALL Statuses 
                    • Individual Location, individual Group Name and individual Status
          • Percentages for the Statuses assigned to the patients at ALL Locations for the 
             following:
                    • ALL Locations, individual Group Name and ALL Statuses 
                    • ALL Locations, individual Group Name and individual Status

Reports > Financial
 (10/20/2021) Financial > Analysis > EDITED: Payments by Payor

• Parameter/Option changes:
          • Department (Request) 
                    • This is a NEW Parameter/Option added.
                    • Option to run the report for payments applied to charges posted for a 
                       specified Department.
                    • Default is '*' for all Departments.
                    • Click in the field to access the drop-down to select a Department, or free-
                       type the Department code into the field.

• Report changes:
          • Report header
                    • Department – Will display either 'ALL' or the specified Department.
          • Summary by Department by Payor
                    • Grand Totals – All Departments – Includes the following:
                              • Total 'Responsible Payments' for ALL Departments
                              • Total 'Insurance Payments' for ALL Departments
                              • Total 'Payments' combined for ALL Departments
                    • Department Total - Lists the Department, then the following Totals:
                              • Total 'Responsible Payments' for the individual Department
                              • Total 'Insurance Payments' for the individual Department
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                              • Total 'Payments' combined for the individual Department
                    • Payor - Lists the Payor name and the following Totals:
                              • The 'Responsible Payments' are 0.00 on this line.
                              • Total 'Insurance Payments' for the individual Department
                              • Total 'Payments' combined for the individual Department
                    • Responsible - Lists the following Totals:
                              • Total 'Responsible Payments' for the individual Department
                              • The 'Insurance Payments' are 0.00 on this line.
                              • Total 'Payments' combined for the individual Department

 (10/7/2021) Financial > Analysis > EDITED: Reimbursement Detail

• Report changes:
          • Payor line – The 'Plan' on the patient's Insurance/Payor screen will display at the
            end of the Payor line. (Request)

 (1/27/2022) Financial > Daily > EDITED: Payment

• Report changes:
          • Any payments with the words 'E-Commerce' in the 'Desc' field, will now be broken 
             out into its own payment method in the following sections of the report: (Request)
                    • Opening Summary
                    • Payment Summary by Posting ID
                    • Report Detail
                    • Deposit Slip

Reports > System Admin.
 (10/8/2021) System Admin. >   EDITED: PracticeWatch Task History

• Report changes:
          • Result Message column – This was renamed to 'Status', and will now display 
             results from the TaskHistory.Status. Examples include the following: (Request) 
                    • Email Exception
                    • Failed
                    • Instant Message Exception
                    • Pending
                    • PHI Audit Exception
                    • Report Failed
                    • Success
                    • Task cannot be deleted
• How to recognize that the Task was successful:
          • The 'Finish' column will display a date and time.
          • The 'Status' column will display 'Success'.

 (4/15/2022) System Admin. >   EDITED: Security User Audit Log

• Report changes:
          • Details
                    • A record will be added when users log into the software; they don’t need to 
                       click on anything else for it to occur. (Request)

 (4/7/2022) System Admin. >   EDITED: User Defined Audit Report

• Report changes:
          • Top header
                    • Result – The report will now merge the ‘Description’ from the ‘Result Code 
                       Definition’ table. (Request)
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Utility > Form Editor
(5/4/2022) Form Editor > New Keywords Available

• gl_edgetrt
          • Keyword now available for adding Edge Treatment to RX_SPECT form. (Request) 

• pat_cphone 
          • Keyword now available for adding patient cell phone to forms. (Request)

Utility > PracticeWatch Setup
 (1/12/2022) PracticeWatch Setup > New Automatic Processes

• The following processes have been moved to PracticeWatch, so they can automatically be 
   sent/received on a daily bases, prior to the office opening:
          • Client License expiration inquiry
                    • Compulink sends an inquiry to the client software to find out when the 
                       license needs to be renewed.
          • Client Configuration file renewal
                    • After receiving the information from the inquiry above, if the client license 
                       needs to be renewed, Compulink will automatically send out an updated 
                       Configuration file.
                    • PracticeWatch will then download that Configuration file on the client side to
                       renew the license.

Utility > System Administrator
 (5/2/2022) Network Utilities > New Utility

• A new Utility ‘Disconnect User’ was added in the event that a user is unable to close out 
  of the Advantage software via the standard method.
• See the I.T. Information section at the end of this document for further details.

 (1/12/2022) System Administrator > Login > IDs > Active Filter

• A new 'Filter' command was added with the following options:
          • Active – When selected, all records with a 'Termination' date that has passed, will 
             filter off of the display.
          • Off – When selected, any Terminated records that were filtered off, will once again 
             display in the table.

 (2/23/2022) System Administrator > Login > IDs > New Field Added

• The new field 'Responsible for Staff Education' was added for future use (in development).
• Value defaults to the same value that was found in the 'Manager' field upon update.

 (3/4/2022) System Administrator > Login > Table Edit Controls > New Feature

• The new feature 'Table Edit Controls' was added to allow the user to control access to 
   areas of the software on a field level, rather than just an area level.
• Administrators may want to give access to the Exam area, but make it mandatory to 
   select from the drop-down table in specific fields; this prevents users from free-texting in
   those fields.
• This control is based upon Login Profile, not individual Login ID.
• The Login Profile must have access to the area to set up additional Controls.
          • If the Login Profile has Ledger access = None, then there is no need to set up 
             additional Controls.
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          • If the Login Profile has Ledger access equal to one of the below, then additional 
             Controls can be established:
                    • Add Only
                    • Add/Edit
                    • Add/Edit/Ins
                    • Full

• Table Commands
          • Search
                    • Use the Search icon to quickly perform an alphabetical search of the 'Name'
                       field in the table.
                    • The 'Select Field to Search' defaults to the only option of 'Name', so just 
                       click 'OK'.
                    • Enter your search characters and click OK.
                    • We recommend that you perform a search prior to adding new records to a 
                       look-up table to confirm the entry doesn't already exist. 
          • Add
                    • Add a new entry to the bottom of the table.
          • Edit
                    • Modify the highlighted entry.
          • Delete
                    • Permanently remove the highlighted entry. 
                    • The following prompt will display: Are you SURE you want to Delete 
                       highlighted item AND ALL Detail entries associated with it?
                    • Click 'Yes' to delete the highlighted entry (there is no UNDO).
          • Detail
                    • Add a Detail record to the highlighted entry.
                    • Add – Used to add the Detail record
                    • Delete – Used to remove the highlighted Detail record
                    • Edit – Used to edit the highlighted Detail record

• Add a New Entry to the Table
          • Use the 'Add' command to open the 'Edit Controls Editing window, and complete 
             the fields.
          • Name – Assign a name to the Control record. Example: Ledger Drop-downs.
          • Start – Date this Control record will start functioning.
                    • Any Login Profile connected to this Control record will not be effected until 
                       the 'Start' date.
          • End – Date this Control record will stop functioning.
                    • Any Login Profile connected to this Control record will no longer be effected 
                       after this 'End' date.
          • Login Profile – The Login Profile that you would like controlled. Example: BILLER.
                    • Login Profiles not assigned in this table, will continue to function as 
                       assigned in the Login Profile Rights table.

• Adding a Detail record
          • To choose a 'Detail' mode, first highlight the Control Name.
          • Select 'Detail > Add'.
                    • In the 'Edit Controls Details Editing' window, complete the fields:
                              • Table
                                        • Select the Table you want to apply the Control Name to. 
                                           Example: LEDGER.
                                        • Click the drop-down and select from the following:
                                                  • BILL – Account Responsible
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                                                  • FRAM_RX – Spectacle Rx
                                                  • LEDGER – Patient Ledger
                                                  • LENS_Rx – Contact Lens Rx
                                                  • PATIENT – Patient Demographics
                              • Field
                                        • Field in the table that you want to control. Example: BODY.
                              • Data Entry Control
                                        • The Control Access you want to assign.
                                        • Click the drop-down and select from the following:
                                                  • Prevent Access – Under development
                                                  • List Select Only – Force user to use the drop-down, 
                                                     and prevent free-texting in the field
                                                  • Unrestricted – Allow full access to the field
                    • Save the record.
          • With the same Control Name highlighted, select 'Detail > Add' to attach additional
             Detail records.

• Completing the Process 
          • When finished adding all items to the table, any user with the Login Profiles 
             assigned, must close to the main screen of the software, Log out, and Log back in 
             to see the changes.

• Example:
          • Control Record
                    • Name = Ledger Drop-downs
                    • Start = Empty, as I want it to start today
                    • End = Empty, as I want this to continue until I make a change
                    • Login Profile = BILLER
          • Detail Record
                    • Table = LEDGER
                    • Field = BODY
                    • Data Entry Control = List Select Only
          • All users with Login Profile of BILLER in the Login IDs table, Log out and in.
          • Results
                    • When posting charges at the patient Ledger, free-texting is prevented in the
                       'Desc' field, and they must select from the drop-down.

 (1/12/2022) System Administrator > Network Utilities > Name Change

• The sub-menu 'Sybase Network Utilities' was renamed to 'Network Utilities.

 (1/12/2022) System Administrator > System Setup > Acct. Billing Tab

• ExpressBill Acct # field
          • The width of the field was increased from 6 to 12 characters to allow for the new 
             Acct# format.

 (4/15/2022) System Administrator > System Setup > System Administrator Tab

• Allow Automatic Config Update field
          • Field was removed, as the process is now handled automatically via PracticeWatch.

• I.M.S. Legacy Migration field
          • Field was removed, as the I.M.S. (Image Management System) is now always on.

• PHI Audit Time Period field
          • The year max was raised to 50 to accommodate for all states. (Request)
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Web Registration
 (3/17/2022) Web Reg > Changes

• Basic Information:
          • In Version 12.5, the current ‘Patient Registration Suite’ is retired, and the process 
             is moved into PracticeWatch and the core Advantage software.
          • This allows Compulink to eliminate the old service completely, eliminate the need 
             for a 2nd service to be installed and provides an easy way to do updates for future
             enhancements and/or security needs.
          • When the practice is updated to 12.5, the old service will no longer be able to pick 
             up registrations, so the new PracticeWatch function will pick them up.
                    • They can also be manually picked up with the new Patient Utility > Web 
                       Registration Refresh.

• Locally installed software:
          • The legacy Patient Registration service software resides on the C drive of each 
             practice’s server.
          • This prevents Compulink from automatically stopping it and uninstalling it during 
             the update to 12.5.
          • Once the practice updates to 12.5, the software will block the legacy program from
             being able to connect to the Compulink server.
          • This allows the practice to uninstall and remove the service at their convenience.
                    • This can be done at any time, as it does not impact anything in the 
                       Advantage software, or prevent the new function from running.

• Behind-the-scenes changes:
          • The method of getting the registration data from the website.
          • Getting that data into the databases within the Advantage software, and displaying
             it in the Web Reg menu.
          • PracticeWatch Interval Processing:
                    • PracticeWatch now picks up the registrations that are pending, and imports 
                       them into the registration databases automatically.
                    • As long as it is running, the program will download all available registrations
                       every 5 minutes.

• Changes at the practice:
          • Nothing changes regarding the basic functionality of adding or updating patient 
             Web Registration data into the Advantage software.
                    • The ‘Web Reg’ command in the following areas still work the same:
                              • Patient
                              • Insurance
                              • Referrals
                              • Exam
          • New Refresh Utility
                    • The practice does have a new option on the Patient screen: Utility > Web 
                       Registration Refresh.
                    • This allows the user to trigger the software to download any new 
                       registrations that might not have been downloaded yet by PracticeWatch.
                    • It pulls the information into the Web Reg list on the Patient screen.
                    • Clients using kiosks in the office no longer have to wait for the timed 
                       interval to pass for the patient to display on the list; they simply select to 
                       Refresh once the patient has submitted their registration.
                    • This option was not available in the legacy service.
          • Multiple websites
                    • If your practice has more than one website (English/Spanish, Child/Adult, 
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Web Registration
                       etc), you will need to contact Compulink Support to assist with configuring 
                       your software to pick up the registrations from the additional sites.

I.T. Specialist Information
 (3/1/2022) System Administrator > Network Utilities > New Utility

• A new Utility ‘Disconnect User’ was added in the event that a user is unable to close out 
  of the Advantage software via the standard method.
• Here is a list of examples of why this might be needed:
          • A record is locked by a user that crashed or walked away from their PC, and is 
             either remote, or in a place that is not accessible by staff.
          • Locked Logon License – For some reason a user’s computer is continuing to crash, 
             and their Advantage Logon is not releasing.
          • A software diagnostics needs to be run, and you are unable to contact the user 
             that might be logged in and preventing it from running.
• This can only be run by a user with Administrative Login Rights.
• Disconnecting a user
          • From the main screen of the software, go to Utility > System Administrator > 
             Network Utilities > Disconnect User.
          • The ‘Select Network user to Kill/Disconnect’ window opens to display the following:
                    • OS Name – Operating System Name
                    • Network Name – Name of the computer on the Network
          • Double click on the user that needs to be disconnected.
          • Confirm that you would like to disconnect user.
          • At this time, the user will be disconnected from the Advantage software, and will 
             receive an error if they click on the already open software.
          • They must end task and re-launch the software to be able to connect again.
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